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การใช้ Joomla 3.7x เบื้องต้น 
 

 

Joomlaคืออะไร 

 เป็น CMS (Content Management System)ในการสร้างเว็บไซต์ที่ได้รับความนิยมเป็นอันดับต้นๆ 
มีเว็บไซต์ที่สร้างจาก Joomla จ านวนหลายล้านเว็บไซต์ เพราะ Joomla มีระบบการจัดการเนื้อหาบน
เว็บไซต์ที่มีรูปแบบสากล การปรับแต่งหน้าตาของเว็บไซต์ท าได้ง่าย เพราะถูกออกแบบมาให้รองรับกับ
เทคโนโลยีการออกแบบเว็บไซต์สมัยใหม่ รองรับการแสดงผลบนอุปกรณ์มือถือ ทัปเลต ฯลฯ นอกจากนี้ยัง
สามารถ Download Template ได้หลากหลาย มีทั้งแบบที่สามารถน ามาใช้งานได้ฟรี หรือหากต้องการ 
Template ที่มีประสิทธิภาพ และมีความสวยงาม ก็สามารถหาซื้อมาใช้ได้ จุดเด่นอีกจุดหนึ่งก็คือมี 
Extension จ านวนมากให้เราสามารถน ามาประยุกต์ใช้งาน เช่น Component, Module, Plugin มีทั้งแบบฟรี 
และแบบต้องช าระเงิน ส าหรับเว็บไซต์อย่างเป็นทางการคือ http://www.joomla.org เป็นศูนย์รวมข่าวสาร
การ Update joomla  และคุณสามารถ download extension ต่าง ๆ ได้ 

 

ข้อดีของ Joomla 

1. ติดตั้งง่ายได้เว็บไซต์อย่างมืออาชีพ 

2. ควบคุมหน้าตาเว็บไซต์ด้วยเท็มเพลต 

3. สร้างและจัดการเน้ือหาได้ง่าย 

4. รอบรับการท างานหลายๆ คนพร้อมกัน 

5. เสถียร ปลอดภัย อัปเดตสม่ าเสมอ 

6. ไม่ต้องยึดติดกับคอมพิวเตอร์หรือซอฟต์แวร์ใดๆ สามารถท างานได้ทุกๆ เบราเซอร์ 

7. มีสังคมออนไลน์ที่มีข้อมูลช่วยเหลือจ านวนมาก 

8. มีการพัฒนาภาษาไทยอย่างเป็นทางการ 

9. สมบูรณ์ด้วยโปรแกรมเสริมที่หลากหลาย 

10. มีการอัพเดทตัวโปรแกรมอยู่เสมอเพื่อความปลอดภัย 

 

 

Part 1 :ภาพรวมและความเข้าใจเบ้ืองต้น เกี่ยวกับ Joomla 
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ลักษณะของเว็บไซต์ Joomla 

    Front End ส่วนหน้าตาแสดงผลของเว็บไซต์ที่ผู้เยี่ยมชมเว็บไซต์ สามารถเข้ามาดูเว็บไซต์ของเราได้ 

 

 
 

 

 

Module 

เมนูการใช้งาน 

Main Menu Content 
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หน้าจอเว็บไซต์ผู้ดูแลระบบ Administrator 

 
การเข้าสู่ระบบเท็มเพลตเว็บไซต์ Joomla กรมส่งเสริมสหกรณ์ 

1.เปิดเบราเซอร์ (โปรแกรมท่องอินเตอร์เน็ต) ขึ้นมา พิมพ์ URL ในช่อง URL ดังนี้ 

                            __________________________________________ 

** เบราเซอร์ ที่สามารถใช้งานได้กับเว็บไซต์ Joomla ได้ทุกเบราเซอร์ ดังนี้ 

 

                                     Chome       Firefox           IE          Opera       Safari 

2. ท าการล็อกอินด้วย Username Password ของท่าน 

 

 

ใสช่ื่อผู้ใช้ และรหัสผา่น 
จากน้ันคลิกปุม่เข้าสู่ระบบ 

หากเข้าสู่ระบบไม่ได้ ให้ตรวจสอบการพมิพ์ตัวสะกดให้ถูกต้อง  
ตัวอักษรเล็กและใหญ่ มีผลต่อการล็อกอินเขา้สู่ระบบ  
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เมื่อเข้าสู่ระบบเรียบร้อยแล้วจะเข้าสู่หน้าจอผู้ดูแลระบบ หรือ Administrator 

 

 

 

การเปลี่ยนรหัสผ่านเพื่อความปลอดภัย 

    
 

เมนูการใช้งาน 

คลิกเพื่อดูหน้าเวบ็ไซต ์

เมนูลัด 

ส่วนแสดงวา่ทา่นท างานอยูท่ีส่่วนใด 

เวอร์ชั่น ออกจากระบบ 

Part 2 : การเซทค่าระบบต่างๆ บนเว็บไซต์ 

1.คลิกสญัลักษณ์ 

2.คลิก Edit Account 

3.ใส่รหัสผ่านใหม่ และ

ยืนยันรหัสผ่าน 

เม่ือเปล่ียนรหัสเรียบร้อยแล้ว ให้ท า
การออกจากระบบ และเข้าสู่ระบบใหม่ 

4.คลิกปุม่ บันทึก&ปิด 

จ านวนผู้เข้าระบบ 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 5 
 

การตั้งค่าระบบหลัก 

เพื่อเป็นการ Setup ค่าต่างๆ ให้กับเว็บไซต์เพื่อที่จะท างานได้รวดเร็วขึ้น และเพื่อให้เว็บไซต์ของเรา
รองรับกับเทคโนโลยีการค้นหาเว็บไซต์ Search Engine Optimization (SEO) โดยไปท่ี  
ระบบ -> ตั้งค่าระบบหลัก 
 

 

 
 
**โดยในตัวช่วยเขียนเนื้อหา เลือกเป็น JCE จึงจะมี เครื่องมือในการช่วยเขียนเน้ือหาที่หลากหลาย 
 

1 

2 

3. ตั้งค่าต่างๆ ตามต้องการ 
โดยตัวช่วยเขียนเนื้อหาเลือก JCE 
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คลิกที่แถบเซิร์ฟเวอร์ ตรงสวนตั้งค่าพื้นที่ เขตเวลา เลือกเป็น Bangkok 

 

 

4.ใส่ค าอธิบายเว็บไซต์ 

5.ใส่ค าค้นหา 

คลิกที่มุม เพื่อยืดขยายช่อง 
การพิมพ์ข้อมูล 

คลิกปุ่มบันทึก & ปิด 

เลือกเขตเวลาเป็น Bangkok 

คือเวลาตามประเทศไทย 

คลิกแถบเซิร์ฟเวอร์ 
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ความเขา้ใจในการจัดการ Content บนเว็บไซต์ 

 ในการจัดท าเว็บไซต์จะตอ้งมีการออกแบบโครงการข้อมูลในเว็บไซต์ก่อน โดย
ก าหนดการแบ่งกลุ่มข้อมูลเป็นกี่กลุ่ม แต่ละกลุ่มมกีลุ่มย่อยอีกหรือไม่ เพื่อน าไปเป็นโครงสร้าง
เว็บไซต์ให้เหมาะสม 

 ประเภทและโครงสร้างของ content ใน Joomla 

1. เนื้อหา (Article) คือข้อมูลหรือเนื้อหาในแต่ละหน้าของเว็บไซต์ 
2. หมวดหมู่ (Category) คือหมวดหมู่ของ เนื้อหา เราสามารถสร้างหมวดหมู่
หลักและหมวดหมู่ย่อยได้ไม่จ ากัด 

 ความสัมพันธ์ของเนื้อหา (Article) และหมวดหมู่ (Category) 

 

 

 

 

 

 

 

ในการท าให้เว็บไซต์ของท่านสามารถค้นหาใน Google ได้ง่าย นั้น ระบบ Search Engine ให้
ความส าคัญกับโครงสร้างเนื้อหามากกว่า หัวข้อเนื้อหา โดยหลักในการสร้างหัวข้อหลักและหัวข้อย่อย ที่

ถูกต้องคือ <h1>,<h2>,<h3>,….. เป็นล าดับต่อเนื่องไปจนถึง <h6>โดย Search Engine จะค้นหาข้อมูลที่มี
น้ าหนักความส าคัญตามล าดับจากหัวข้อแท็กที่ก าหนด โดยมีความส าคัญมากกว่าข้อความธรรมดา 

 

Part 3 :การสร้าง บทความ เน้ือหาเว็บ (content) 

หมวดหมูย่่อย 1 
Sub Category 1 

หมวดหมูย่่อย 2 
Sub Category 2 

หมวดหมู่ 

1 

 

 

 

เนือ้หา 1 
Article 1 

เนื้อหา 2 
Article 2 

เนื้อหา 3 
Article 3 

ตัวอย่างการพิมพ ์ค าค้นหา ค าค้นหาที่1,ค าค้นหาที่2,ค าค้นหาที่3,.............ค าค้นหาท่ี 1000 
เช่น ศูนย์เทคโนโลยีสารสนเทศและการสื่อกสาร กรมส่งเสริมสหกรณ์,ศูนย์สารสนเทศ กรมส่งเสริมสหกรณ์

,ITC CPD,ไอทีกรมส่งเสริมสหกรณ์ 
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จากภาพ Category หรือ หมวดหมู่ เปรียบเสมือน โฟลเดอร์ท่ีไว้เก็บข้อมูลต่างๆ ในระบบ 
จากภาพ Article หรือ เนื้อหา เปรียบเสมือนไฟล์ต่างๆ ที่ถูกเก็บอยู่ในโฟลเดอร์น่ันเอง  

** ในการสร้าง Content ต่างๆ ในระบบเว็บไซต์ Joomla นั้น ท่านควรจะสร้างๆ หมวดหมู่หรือ 

Category ก่อนที่จะสร้างเนื้อหา Article เพื่อสะดวกในการจัดการการนั่นเอง 

ตัวอย่างการท าโครงสร้างข้อมูลเพ่ือจ าแนกเนือ้หาต่างๆ บนเว็บไซต์ 

 

 

1. การสร้างหมวดหมู่ (Category) 

   1.1 ไปที่เมนู เนื้อหา > หมวดหมู่ > เพิ่มหมวดหมู่ใหม่ 

 
1.2 ตั้งชื่อหมวดหมู่ตามต้องการ 

 

เกี่ยวกับสหกรณ์ 

วิสัยทัศน์ พันธกิจ 

ประวัติสหกรณ์ 

บุคลากร 

สินค้าและบริการ 
สินค้าของเรา 

บริการของเรา 

ตั้งชื่อหมวดหมู่ตามต้องการ ใส่ชื่อ เอเลียส์ตามต้องการ 
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** เอเลียส์ คือ ชื่อที่จะแสดงแทนชื่อหน้าข้อมูลเว็บเพจที่เราสร้างขึ้น หากเราตั้งชื่อ เอเลียส์เป็นอะไร 

ก็จะไปปรากฏที่แถบแสดง URL บนเบราเซอร์ และไว้ใช้ในการอ้างอิงการเรียกเว็บเพจขึ้นมาแสดง 
ตัวอย่างการตั้งชื่อ ถ้าชื่อหมวดหมู่เป็น เกี่ยวกับหน่วยงาน เอเลียส์อาจจะตั้งค่า about เป็นต้น 

1.3 จากนั้นกดปุ่ม บันทึก 

การลบหมวดหมู ่
1. ไปที่เมนู เนื้อหา เลือกหมวดหมู่ (คลิกค าว่าหมวดหมู่) 

 

2. ท าการเลือกหมวดหมู่ที่ไม่ต้องการ โดยท าเครื่องหมาย หน้าหมวดหมู่ที่ไม่ต้องการ 
3. ท าการคลิกปุ่มถังขยะ 

 

**ในการลบหมวดหมู่น้ันในความเป็นจริงแล้วยังไม่ได้ลบออกไปจากระบบ เพียงแต่ท าการย้าย

หมวดที่ไม่ต้องการ ไปไว้ในถังขยะ และเราสามารถกู้คืนหมวดหมู่ที่เราลบไปแล้วได้ 

 

2 
3 
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การกู้หมวดหมู่ทีล่บจากถังขยะกลับมาใหม ่

1. ไปที่เมนู เนื้อหา เลือกหมวดหมู่ (คลิกค าว่าหมวดหมู่) 

 
2. คลิกที่เครื่องมือการค้นหา 
3. เลือกสถานะเป็น อยู่ในถึงขยะ 

 
 
4. จะเจอหมวดหมู่ ที่เราได้ท าการลบลงในถังขยะ 
5. เลือกหมวดหมู่ที่ต้องการกู้คืน โดยการคลิก  หน้าหมวดหมู่ที่ต้องการ จากนั้นคลิกที่ปุ่ม เผยแพร่ 

 

 

2 

3 

5.1 

5.2 

หรือคลิกที่ตรงนี้ก็ได้เช่นกัน 
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2. การสร้างเนื้อหา Article 

    2.1 ไปที่เมนู เนื้อหา > เนื้อหา > เพิ่มเนื้อหาใหม่ 

 
  2.2 พิมพ์เนื้อหาที่ต้องการ 

 

เมื่อพิมพ์ข้อมูลที่ต้องการเสร็จเรียบร้อยแล้ว เซทค่าทางด้านขวามือ 

 

ตั้งชื่อเน้ือหาตามต้องการและเอเลียส์ตามต้องการ 

พิมพ์ข้อมูลตามต้องการ 

เลือกสถานะ  

เลือกหมวดหมู่ คือ ให้เนื้อหาน้ีอยู่ในหมวดหมู่ใด 

เลือกเด่น ให้เนื้อหานี้แสดงอยู่ในหน้าแรกของ
เว็บไซต์หรือไม่ 
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ค าอธิบาย 

 

ลักษณะการบันทึกข้อมูล 

 

 

 

 

------------------------------------------------------------------------------------------------------------------------------------- 

เครื่องมือต่างๆ ในการพิมพ์ข้อมูล  

 

1. Font Family คือแบบอักษร // Font Size คือขนาดตัวอักษร 

2. เครื่องการสร้างตาราง ลบตาราง ลบแถว เพิ่มแถว และผสานเซลล์ 

3. เครื่องมือ การล้างรูปแบบต่างๆ ที่ติดมากับโปรแรมอื่นเช่น Word , Excel ,Powerpoint เพื่อให้สามารถ
จัดรูปแบบข้อมูลได้ 

4. การท าลิงค์เชื่อมโยงข้อมูล 

5. การแทรก Read more หรือ อ่านเพิ่มเติม 
 

- เผยแพร่ คือ ให้แสดงผลบนเว็บไซต์ได้  

- ไม่เผยแพร่ คือ ซ่อนการแสดงผลบนเว็บไซต์ 
- คลังเน้ือหา คือ ให้เน้ือหาน้ี ไปเก็บอยู่ในคลังเน้ือหา 

- อยู่ในถังขยะ คอื ให้เน้ือหาน้ีอยู่ในถังขยะ(ลบ) 

บันทึกเน้ือหาน้ี ก็จะคา้งอยูใ่นหน้าเน้ือหาน้ัน
ไม่เปลี่ยนหน้าไปไหน 

บันทึกเน้ือหาน้ี แล้วปิดหน้าเน้ือหาน้ี 

บันทึกเน้ือหานี้ และปิดหน้าเน้ือหาน้ี แล้วท าการสร้าง
หน้าการสร้างเน้ือหาใหม่เปลา่ๆ ให้อัตโนมัต ิ

1 
2 

4 5 

3 
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การใช้เครื่องมอืการแทรกรูปภาพ แบบที่ 1  

1. เอา cursor เมาส์ไว้ตรงจุดที่ต้องการแทรกรูปภาพ 
2. คลิกปุ่มใส่รูปภาพ 

 

3. เลื่อน scrollbar ลงด้านล่างคลิกปุ่ม Choose File เพือ่ท าการเลือกรูปส าหรับ Upload ข้อมูล  
4. จากนั้นกดปุ่ม เริ่มอัพโหลดไฟล์ 

 

5. รอสักครู่ รูปที่อัพโหลดจะปรากฏในช่องแสดงรูปตัวอย่าง จากนั้นคลิกที่รูป 
6. สังเกตุว่าเมื่อคลิกที่รูปแล้ว ช่องที่อยู่รูปมี URL ชื่อรูปปรากฏหรือไม่ หากไม่มี จะแทรกรูปท่ีต้องการไม่ได้ 
7. คลิกปุ่ม เพิ่มในเนื้อหา 

2 

3 4 
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**ในการอัพขอ้มูลรูปภาพ จะต้องมีขนาดไม่เกิน 2 MB และชื่อไฟล์ตอ้งเป็นตัวเลขหรือ
ตัวหนังสือภาษาอังกฤษ เท่านั้น ถ้าหากไฟล์เป็นชื่อภาษาไทย เมื่ออพัโหลดแล้วจะท าการ
แทรกรูปภาพไม่ได ้

ผลลัพธ์ 

 

การใช้เครื่องมอืการแทรกรูปภาพ แบบที่ 2 
1. คลิกที่สัญลักษณ์ insert/modify images 

 

5 
7 

6 

1 
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2. คลิกที่สัญลักษณ์ Upload 

 

 

3. คลิกที่ปุ่ม Browse แล้วเลือกไฟล์ที่ต้องการสามารถเลือกได้หลายๆ ไฟล์พร้อมๆ กัน ชื่อไฟล์จะปรากฎอยู่
ที่ช่อง Upload 
4. คลิกปุ่ม Upload เพื่อ อัพโหลดไฟล์ที่เลือก 

5. รูปที่อัพโหลดเสร็จแล้วจะปรากฎอยู่ในชองแสดงรูป  
6. คลิกที่ชื่อรูป แล้วกดปุ่ม Insert 

2 

3 4 
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การแทรกตารางในเนือ้หา 

1. คลิกที่สัญลักษณ์ตาราง แล้ววาดช่องตารางตามต้องการ 

 

2. ตารางจะปรากฏในพื้นที่การพิมพ์ แต่ตารางจะยังไม่มีสีและเส้นตาราง เราต้องเป็นคนก าหนดค่าต่างๆ 
เองตามต้องการ 

1 

5 

6 
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3. คลิกลากตารางให้มีความกว้างตามต้องการ 

 
 

4. เซทค่าตารางต่างๆ ให้ท าการคลิกขวาในตารางที่ต้องการ  

 

 

 

2 

Table Properties เป็นการเซทค่าทั้งตาราง 

Cell เป็นการเซทค่าแต่ละเซลล์(ช่อง) 
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 4.1 เซทค่าทั้งตาราง  

    

        4.2 เซทค่าต่างๆ แต่ละช่องเซล สามารถลากแถบด าคลุมได้หลายๆ เซล หรือ ทีละเซลก็ได้ จากนั้น
คลิกขวา เลือก Cell > Table Cell properties 

 

       4.3 เซทค่าต่างๆ แต่ละช่องเซลตามต้องการ 

  

เซทค่าความกว้าง, ความสูง 
ความหนาเส้นขอบ , ช่องว่าง
ระหว่างเซล 

เซทสีเส้นขอบและ สีทั้งตาราง 

4.2 

ลากแถบด าคลุมช่องที่ตอ้งการ ถ้า
ต้องการเปลี่ยนแค่ 1 ช่องให้น า 
cursor เมาส์ วางในช่องนั้น 

เซทค่าความกว้าง, ความสูง 

ความหนาเส้นขอบ , ช่องว่าง
ระหว่างเซล 

เซทสีเส้นขอบและ สีทั้งตาราง 
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ผลลัพธ์  

 

** ในการท าตารางแนะน าว่า ให้เซทเพียงครั้งเดียวเช่น ท าสี ท าเส้นขอบ จัดข้อความ  

อย่าท าไปเซทไปหลายครั้ง เพราะจะต้องเซทใหม่ต้ังแต่แรกที่ท าไว้ 

เครื่องมือตารางเพิ่มเติม 

 

 

 

 

 

 

การท าลิงค์การเชื่อมโยง 
         การท าลิงค์เชื่อมโยงในเว็บไซต์แบ่งออกเป็น การเชื่อมโยง 3 ประเภท 
1. ลิงค์เชื่อมโยงเนื้อหาภายในเว็บไซต์ 
2. ลิงค์เชื่อมโยงไฟล์เอกสาร 
3. ลิงค์เชื่อมโยงภายนอกเว็บไซต์ 
 

 

 

เก่ียวกับการเพิ่มแถว ลบแถว 

เก่ียวกับการเพิ่มคอลัมน์ ลบคอลัมน์ 

ผสานเซลส์ และยกเลิกผสานเซลส ์
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วิธีการท าลิงค์ 
1. ท าการเลือกข้อความหรือรูปที่ต้องการท าลิงค์ 
2. คลิกสัญลักษณ์การท าการเชื่อมโยง (Insert/Edit Link) 

 
ใส่ลิงค์ตามต้องการ แล้วกดปุ่ม Insert 

 
 

 

2 

ใส่ URL เว็บไซต์ที่ต้องท าลิงค์ หรือ 
URL จาก Google Drive 

คลิกเพื่ออัพโหลดไฟล์เอกสาร เช่น 
Pdf , word , excel , ppt ฯลฯ 

หากต้องการเลือกเน้ือหาทีอ่ยู่
ภายในเวบ็ไซต์ คลิกที่ Content 

คลิกหมวดหมูท่ี่ต้องการ 

คลิกเน้ือหาที่ต้องการ 

ค้นหาชื่อเน้ือหาที่ต้องการ 

ส่วนเลือกเน้ือหาภายในเวบ็ไซต์ 

ให้ท าการเปิดลิงค์แบบใด  
open in new window คือเปิดหน้าต่างใหม ่
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การยกเลิกการเชื่อมโยงลิงค์ 

 
1. ท าการเลือกรูปหรือข้อความที่เราท าลิงค์ไว้ 
2. คลิกที่สัญลักษณ์ Unlink 

การใช้งานปุม่ Read More (อ่านเพ่ิมเติม) 

เนื้อหาที่แสดงที่หน้าแรกของเว็บไซต์จะมีความยาวของข้อมูลมาก หากน ามาแสดงทั้งหมด จะท าให้
รูปแบบหน้าเว็บไซต์ ไม่สมดุล และไม่เป็นระเบียบ ดังนั้นปุ่ม read more จึงเป็นฟังก์ชั่น ตัดข้อมูลที่จะ
แสดงผลหน้าแรกให้แสดงแค่บางส่วน และมีปุ่มอ่านเพิ่มเติมขึ้นมา เพื่อให้ผู้ใช้งานต้องการอ่านข้อมูลทั้งหมด
คลิกเพื่ออ่านข้อมูลได้หมด วิธีการดังน้ี 
1. เอา cursor เมาส์ไว้ตรงต าแหน่งที่ต้องการตัดค าเพื่อให้ แสดงผลบางส่วนบนหน้าเว็บ 

 
2. คลิกที่ปุ่ม Read More 

 

 

 

 

จุดที่ต้องการตัดข้อมูลให้แสดงหน้าแรก 

2 

คลิกสัญลักษณ์ Unlink 
เพื่อยกเลิกการเชือ่มโยง 
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3. จะปรากฏเส้นก าหนดขอบเขตของ Read more 

 

        ผลลัพธ์ที่ได้ 

 

** การใส่ Readmore จะมีผลกับเนื้อหาที่แสดงที่หน้าแรกของเว็บไซต์เท่านั้น  

และไม่สามารถแสดงได้ในโมดูล 

 

 

 

 

 

 

เส้นแบ่ง Readmore 

ปุ่มอา่นเพิ่มเติมจะปรากฏขึ้นมา 
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สถานะต่างๆ ของเนื้อหาในระบบ 

 

** วิธีการเปลี่ยนสถานะเนื้อหาต่างๆ ให้คลิกที่สัญลักษณ์นั้นได้เลย 

** หากเนื้อหาใดมีสถานะ รูป เครื่องหมายตกใจ สีเหลือง  หมายความว่าบทความนั้นมีการตั้งเวลาการ
แสดงผล 

** หากเนื้อหาใดมีสถานะ รูป แม่กุญแจเกิดขึ้น  หมายความว่า เนื้อหานั้น มีการบันทึกไม่ครบถ้วน 
อาจจะท าให้เนื้อหานั้นแสดงผลบนหน้าเว็บไม่สมบูรณ์ ให้ท าการเข้าไปในเนื้อหานั้นแล้วท าการบันทึกซ้ าอีก
ครั้งหนึ่ง 

 

การท าข่าวกิจกรรมในระบบเวบ็ไซต์ Joomla 

สิ่งที่ท่านต้องเตรียมเพื่อท าข่าวกิจกรรมมีดังนี้ 
1. เนื้อหาของข่าว 
2. ภาพที่จะท าเป็น Gallery ภาพข่าว 
3. ภาพตัวอย่างข่าว (อาจจะท าเป็นรูปภาพตัวอย่างข่าวขนาดเล็กเพื่อ ให้ เบราเซอร์ IE แสดงผลข่าวไม่
ผิดเพี้ยน) 
 

เร่ิมท าข่าวกิจกรรม 
**** ในการท าขา่วกิจกรรมนั้น แนะน าว่า ให้ท าจากข่าวที่เก่าที่สุด มายัง ข่าวที่ใหม่ที่สุด
เพ่ือไม่ต้องเซทค่าการเรียงล าดับให้ยุ่งยาก 

 

กากบาทสีแดงคือไม่เผยแพร่เน้ือหานั้นขึ้นเว็บไซต์ 

เคร่ืองหมายถูกสีเขยีวคอื เผยแพร่เน้ือหาน้ันขึ้นเว็บไซต ์

เคร่ืองหมายดาวสีเหลือง คอื เน้ือหาน้ีเป็นเน้ือหาเด่นแสดงอยู่หน้าแรก
ของเว็บไซต์ 

เคร่ืองหมายดาวสขีาว คือ เน้ือหาน้ีไม่ได้เป็นเน้ือหาเด่น 
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1. ท าการอัพโหลดรูป Gallery ที่มีเดีย  

 

2. สร้างโฟลเดอร์ใหม่ เพื่อเก็บรูปใน Gallery ท าการตั้งชื่อโฟลเดอร์ โดยชื่อโฟลเดอร์เป็นภาษาอังกฤษ เช่น 
ข่าววันท่ี 20 มิถุนายน 2560 ก็ตั้งชื่อเป็น 20june2560  ถ้ามีหลายๆข่าวในวันเดียว อาจจะตั้งเป็น 
20june2560_2 

 

 

3. คลิกที่ชื่อโฟลเดอร์ท่ีสร้างเพื่อเข้าไปยังโฟลเดอร์นั้น และท าการอัพโหลดไฟล์ลงในโฟลเดอร์ท่ีสร้างไว้  

 
 

2.1 
2.2 ตั้งชื่อโฟลเดอร์ 

2.3 กดปุ่มสร้างโฟลเดอร์ 

3 
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4. ท าการอัพโหลดไฟล์รูปขึ้นเว็บไซต์ โดยช่ือของรูปน้ัน ต้องเป็นภาษาอังกฤษหรือตัวเลขเท่านั้น 

  

5. เมื่อเตรียมรูปเรียบร้อยแล้ว ท าการเริ่มสร้างเนื้อหา ไปที่เมนู เนื้อหา > เนื้อหา > เพิ่มเนื้อหาใหม่ 

 

6. ตั้งชื่อเนื้อหาและเอเลียส์ตามข่าวที่ต้องการ

 

คลิกเพื่ออพัโหลดไฟล์รูปตาม
ต้องการ 
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7. พิมพ์ข่าวที่ต้องการลงไป ต้องการตัดข่าวเพื่อให้แสดงที่หน้าแรก ตรงไหนให้เอา cursor เมาส์ไปวางตรง
นั้น แล้วคลิกที่ปุ่ม Readmore 

 

 

ค าอธิบาย 

 

วาง cursor เพื่อจะท าการตัดข่าว 

คลิกปุ่ม Insert Readmore 

จะได้เส้น Readmore 

คือส่วนที่จะปรากฎในหน้าแรกของเว็บไซต์ 
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8. คลิกที่แถบรูปและลิงค์  เพื่อท าการใส่รูปตัวอย่างที่จะแสดงในหน้าแรก 

 

9. คลิกกลับมาในแถบ เนื้อหา เพื่อพิมพ์ค าสั่ง สร้าง Gallery ภาพข่าว 
    พิมพ์ code ดังต่อไปนี้ ในเนื้อหาข่าว {gallery}20june2560{/gallery}  20june2560 คือชื่อโฟลเดอร์สร้าง
ขึ้นและอัพโหลดรูปข่าวเอาไว้ โดยการพิมพ์ค าสั่งนี้ เราจะต้องแน่ใจว่าได้ท าการเปิด plug in  
Simple Images Gallery แล้ว 

 

10 เลือกหมวดหมู่ ที่จะเก็บเนื้อหาไว้ใน หมวดหมู่ ข่าวกิจกรรม และท าการบันทึกและปิด 

 

คลิกปุ่มเลือก เพื่อเลือกรูปส่วนต้น 

คลิกแถบรูปและลิงค์ 

เก็บไว้ในข่าวกิจกรรม 

พิมพ์โค๊ด เพื่อ สร้าง Gallery 
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11. เมื่อบันทึกเรียบร้อยแล้ว ท าการติดดาวเหลือง เพื่อท าเป็นเนื้อหาเด่น ให้ปรากฏที่หน้าแรกของเว็บไซต์ 

 

 

การลบเนื้อหาที่ไม่ต้องการออก 
1. ไปที่เมนู เนื้อหา > เนื้อหา 

 

 

 

 

คลิกดาวเหลืองท าเป็นเนื้อหาเด่น 

คือส่วนที่จะปรากฏในหน้าแรกของเว็บไซต์ 
ได้มาจากการแทรกปุ่ม insert readmore 

รูปตัวอย่าง เกิดจาก การใส่รูปและลิงค์ 
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2. คลิกเลือกเนื้อหาท่ีต้องการลบทิ้ง โดยคลิก  หน้าเนื้อหาท่ีต้องการลบ 
3. คลิกปุ่มถังขยะ 

 

การกู้คืนไฟล์เนื้อหาทีล่บลงในถังขยะ 

          วิธีการท าแบบเดียวกับ กู้คืนหมวดหมู่ ในหน้าที่ 10 

 
 

การสร้างเมนูเช่ือมโยงเนื้อหา 

การท าเมนูเชื่อมโยงเนื้อหานั้นมีการท าเมนูสองแบบ 

1. การท า Menu ที่อยู่ด้านบน 

2. การท า Sub menu ย่อย 

 

 

 

 

Menu ด้านบน 

Sub Menu 

Part 4 :การสร้างเมนูเชื่อมโยงเนื้อหา 

2 
3 
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วิธีการสร้าง Menu ที่อยูด่้านบน (TOP) 

 1. ไปที่ค าสั่ง เมนู > Top > เพิ่มเมนูใหม่ 

 

 2. ตั้งชื่อเมนูท่ีต้องการในช่องเมนูและเอเลี่ยส์ให้เรียบร้อย   
          3. เลือกชนิดของเมนูน้ันคลิกปุ่มเลือกสีน้ าเงิน 

 

 4. เลือกชนิดเมนูท่ีต้องการ 

4.1 ให้เลือกเนื้อหา > เนื้อหาเดี่ยว 

 

2 

3 

4.1 

4.1 
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 4.2 เลือกเนื้อหา คลิกปุ่มเลือกสีเทา 

 

4.3 เลือกเนื้อหาท่ีต้องการ โดยคลิกไปที่ชื่อเนื้อหาที่ต้องการได้เลย หรือค้นหาจากช่องค้นหา 

 

5. คลิกปุ่มบันทึกเพื่อท าการบันทึก Menu Top 

ผลลัพธ์ที่ได้ เมนูที่สร้างใหม่จะปรากฎขึ้นด้านบน 

 

 

 

 

 

 

4.2 

4.3 

ค้นหาเน้ือหาที่ต้องการ 

เมนูที่เพิ่มขึ้นใหม ่
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** หมายเหตุ การสร้าง Menu TOP นั้นหากต้องการให้เมนูที่สร้างนั้น คลิกแล้วเชื่อมโยงไปยังเนื้อหา

ที่ต้องการ , ลิงค์ไฟล์ , ลิงค์ URL ที่ต้องการ 

6. ท าเมนูเพื่อลิงค์ไปหา URL ที่ต้องการ ให้คลิกที่ ลิงค์ระบบ > URL ภายนอก 

 

7. ในช่องลิงค์ใส่ URL ที่ต้องการ ช่องหน้าต่างเบราเซอร์เป้าหมายเลือกตามต้องการ 

 

โดยวิธีการใส่ URL นั้นพิมพ์ได้ดังนี้ 

         http://www.cpd.go.th แบบนี้ ใส่ถูก               www.cpd.go.th แบบนี้ใส่ผิด 

     7.1 หากต้องการท าเมนูลิงค์ไปยังไฟล์เอกสารที่ต้องการ ให้ใส่ในช่องลิงค์ดังต่อไปนี้ 
          images/ชื่อไฟล์ที่ต้องการ.นามสกุลไฟล์ เช่น images/data.pdf เป็นต้น หากมีการอัพโหลด
ไฟล์ข้อมูลใส่โฟลเดอร์จะต้องอ้างชื่อโฟลเดอร์ในการเรียกไฟล์ให้ถูกต้องด้วย เช่น images/data60/coop.pdf 
** โดยไฟล์นั้นจะต้องอัพโหลดขึ้นในมีเดียก่อน 

8. คลิกปุ่มบันทึกเพื่อท าการบันทึก Menu TOP 

 

 

6 

6 

7 

7 
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วิธีการสร้าง Sub Menu 

 ในการท า Sub Menu นั้นเราจะต้องสร้าง (เมนูแม่) ที่อยู่ด้านบนให้เรียบร้อยเสียก่อน จึงจะท า Sub 
Menu (เมนูลูก) ขึ้นมาได้ 

** การท า Menu ด้านบน(TOP) ส าหรับ ท า Sub menu  

1. ไปที่ค าสั่ง เมนู > Top > เพิ่มเมนูใหม่ 

 

 2. ตั้งชื่อเมนูท่ีต้องการในช่องเมนู     
          3. ชนิดของเมนูน้ันคลิกปุ่มเลือกสีน้ าเงิน 

 

 4. เลือกชนิดเมนูที่ต้องการ เลือกเป็น ลิงค์ระบบ > URL ภายนอก 

 

2 

3 

4 

4 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 34 
 

5. ช่องลิงก์ ใส่เครื่องหมาย # เพื่อให้เมนูแม่นี้ ไม่สามารถคลิกลิงค์ไปได้ ให้เพียงแค่เอาเมาส์

วางบนเมนูแล้วจะมีเมนูลูก ปรากฏขึ้นมา 

6. จากนั้นคลิกปุ่ม บันทึก 

 

** การท า Sub Menu (เมนูลูก) 

1. ไปที่ค าสั่ง เมนู > TOP > เพิ่มเมนูใหม่ 

 

 2. ตั้งชื่อเมนูท่ีต้องการในช่องเมนู    3. ชนิดของเมนูน้ันคลิกปุ่มเลือกสีน้ าเงิน 

 

 

5 

2 

3 
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4. เลือกชนิดเมนูที่ต้องการ 

4.1 ให้เลือกเนื้อหา > เนื้อหาเดี่ยว 

 

 4.2 เลือกเนื้อหา คลิกปุ่มเลือกสีเทา 

 

4.3 เลือกเนื้อหาท่ีต้องการ โดยคลิกไปที่ชื่อเนื้อหาที่ต้องการได้เลย หรือค้นหาจากช่องค้นหา 

 

 

4.1 

4.1 

4.2 

4.3 

ค้นหาเน้ือหาที่ต้องการ 
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 5.ท าการตั้งค่าเมนูลูก ทางด้านขวามือดังนี้ 

 

อธิบายตัวอย่าง 

 

 

6. เมื่อเซทค่าเรียบร้อยแล้ว กดปุ่ม บันทึก 

การเปิด Option ให้เมนู Drop Down ท างาน 

 **เน่ืองจากการท า เมนูที่มีการ Drop เมนูลงมานั้น เราจะต้องท าการเปิดการตั้งค่าบางอย่าง
เพื่อให้เมนูนั้นท างานขึ้นมา ซึ่งเราท าเพียงแค่ครั้งเดียว 

 เมนูต่างๆ ที่อยู่บนหน้าเว็บไซต์ทั้งหมดนั้นเป็น โมดูลการท างาน ดังนั้นเราจึงต้องไปเปิดการตั้งค่า 
ที่ในส่วนของ โมดูล (Module) 

 

เลือกว่าเมนูลูกที่สร้างนี้จะให้อยู่ภายใต้ 
เมนูแม่ ตัวใด 

สัญลักษณ์ – (หนึ่งขีด) หมายถึงเมนูที่อยู่ 
Level บนสุด 
สัญลักษณ์ - - (สองขีด) หมายถึง เมนูที่อยู่ 
Level รองลงมาจากบนสุด 

อยู่เลเวลบนสุด เปรียบเสมือน  
- (หน่ึงขีด) 

อยู่เลเวลรองจากบนสุด 
เปรียบเสมือน - - (สองขีด) 
- (หน่ึงขีด) 

อยู่เลเวลอันดับสาม 
เปรียบเสมือน - - -(สามขีด) 
- (หน่ึงขีด) 
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1. ไปที่ส่วนเสริม > โมดูล 

    

2.ค้นหาโมดูลที่ชื่อว่า TOP ในช่อง ค้นหา

 

3. คลิกไปที่ชื่อ TOP 

 

4. ท าการเปลี่ยนค่าการแสดงเมนูย่อย เป็น ใช่ แล้วท าการบันทึกข้อมูล 

 
----------------------------------------------------------------------------------------------------------------------------- 

พิมพช์ื่อโมดูลลงในชอ่งค้นหา 

3 
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การท าเมนู ดา้นขา้งของเว็บไซต์ 

**การท าเมนูด้านข้าง จากเมนูของเว็บ จะท าให้หน้าข้อมูลที่เราจะเชื่อมโยงไปนั้น ไม่มีโมดูลอื่นติด
ไปด้วย ซึ่งต่างจาก โมดูลที่เราสร้างแบบ ก าหนด HTML เอง หากเราสร้าง เมนูด้านข้าง จากโมดูล

ก าหนด HTML เอง เม่ือเชื่อมโยงไปยังเนื้อหาในเว็บ จะมีโมดูลอื่นติดมาด้วย 

 

1. จะต้องท าการสร้างหมวดหมู่ของเมนูข้ึนมาใหม่ก่อน โดยไปที่ เมนู > การจัดการ > เพิ่มกลุ่มเมนูใหม่ 

 

2. ท าการตั้งชื่อ , ชื่อแบบยูนิค และท าการบันทึกและปิด 

 

 

ท ำกำรตั้งชื่อ 

ท ำกำรตั้งชื่อแบบยูนิค 
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3. เราจะได้กลุ่มของเมนู NewMenu (หรือตามชื่อที่ท่านสร้าง) ขึ้นมา 

 

4. ท าการสร้างเมนู ในกลุ่มของ NewMenu โดยไปที่ เมนู > NewMenu(กลุ่มเมนูที่ท่านสร้าง) > เพิ่มเมนูใหม่ 

 

5. ท าการสร้างเมนูตามต้องการ และท าการบันทึกและปิด 

 

6. จะได้เมนูท่ีต้องการ ซึ่งอยู่ในกลุ่มของเมนู NewMenu (กลุ่มเมนูที่ท่านสร้าง) 
 
 
 

จะได้กลุม่ของเมนู 
NewMenu 

เพิ่มเมนูในกลุม่ 
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7. เมื่อท าเมนูในกลุ่มเสร็จแล้ว ท าการสร้าง โมดูล ชนิด เมนู เพื่อไว้ทางด้านขวาของหน้าเว็บไซต์ 

โดยไปท่ี ส่วนเสริม > โมดูล แล้วคลิกสร้างใหม่ 

 

8. ท าการเลือกชนิดโมดูล เป็น เมนู 

 

9. ตั้งชื่อโมดูล เลือกเมนู เป็น NewMenu(กลุ่มเมนูที่ท่านสร้างขึ้น) 

 

 

 

8 

7.2 

9.1 

9.2 

7.1 
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10.  คลิกแถบการก าหนดแสดงที่เมนู ก าหนดการแสดงผลว่าจะให้แสดงที่หน้าใดบ้าง 

 

11. ทางด้านขวามือ ก าหนดว่า จะให้แสดงโมดูลที่ท าแหน่งใด Right Position 7 คอื ต าแหน่งด้านขวามือ 
ของเทมเพลต Protostar จากนั้นก็กดปุ่ม บันทึกและปิด 

 

12. เมนูท่ีท่านสร้างขึ้นก็จะปรากฏทางด้านขวามือของเว็บ 

 

10.1 

10.2 

11 

12 
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การลบกลุ่มของเมนูที่ไม่ต้องการ 
1. ไปที่เมนู > การจัดการ 

 
 
2. คลิกเลือกกลุ่มเมนูที่ต้องการลบทิ้งออก 
3. คลิกปุ่มลบ เพื่อลบ 

 

 

 

 

 

 

 

2 

3 
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การเซทหน้าแรกของเว็บไซต์ 
            การเซทหน้าแรกของเว็บไซต์นั้นเราจะไปเซทที่เมนู ที่ชื่อว่า หน้าหลัก หรือ Home ซึ่งเมนูน้ีถ้าท า
การลบออกไป จะท าให้หน้าแรกของเว็บไซต์เข้าไม่ได้ 

 1. เมนู > TOP   

 ** หากกลุ่มของเมนูใด มีสัญลักษณ์ รูปบ้าน หมายความว่า ก าหนดกลุ่มของเมนูนั้นให้เป็น
หน้าแรกของเว็บไซต์ 

 
 2. คลิกที่หน้าหลัก เพื่อท าการเซทค่าต่างๆ โดยสังเกตุว่า เมนูใดที่มีสัญลักษณ์ ดาวเหลือง จะเป็น
เมนูที่เป็นหน้าแรกของเว็บไซต์ 

 

 

  3. เลือกชนิดของเมนู โดยคลิกปุ่มเลือกสีน้ าเงิน 

 

 

2 

จุดสังเกตุดาวเหลืองว่าเป็นหน้าแรกของ
เว็บไซต ์

3 
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 4. เลือกชนิดของเมนู เป็น เนื้อหา > เนื้อหาเด่น (คือเนื้อหาท่ีติดดาวเหลือง) 

  
5. คลิกที่แถบตัวเลือกเค้าโครง  

          6. เลือกหมวดหมู่ที่ต้องการ ในที่น่ีคือข่าวกิจกรรม 
          7. ก าหนดจ านวนข่าวกิจกรรมที่จะแสดงบนหน้าเว็บไซต์ 

   
** บทความน า คือ เนื้อหาที่จะแสดงผลในแนวนอน ว่าจะให้กี่เนื้อหาในแนวนอน 
** เน้ือหารองคือ เน้ือหาที่จะให้แสดงอยู่บนหน้าเว็บว่าต้องการให้โชว์กี่เนื้อหา 

** คอลัมน์คือจ านวน คอลัมน์ ในหน้าแสดงผลของหน้าเว็บ  

ตัวอย่าง ท าการเซทค่า บทความน า 0  // บทความรอง 6 // จ านวนคอลัมน์ 3 
 

4 

4 

6 

5 

7 
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อธิบาย - บทความรอง ท าการเซทค่าไว้ 6 จะแสดงเนื้อหาเด่นบนหน้าเว็บไซต์ 6 และท าการเซทคอลัมน์

การแสดงผลไว้ 3 คอลัมน์ เนื้อหาเด่นที่เกินไปกว่า 6 เนื้อหาจะถูกแสดงในหน้าถัดไป 

 

แสดงผังโครงสร้างการวางเนื้อหาของระบบเว็บไซต์ Joomla 

 

 

 

 

 

 

 

 

 

โลโก้ 

เมนูการใช้งาน 

บทความน า 

บทความน า 

บทความรอง บทความรอง บทความรอง 

ถัดไป หน้า    1 
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การเรียงล าดับเนื้อหาในการแสดงผล 

1. คลิกที่สัญลักษณ์ เพื่อปลดล็อก การสลับล าดับเนื้อหา 

 

2. จุดไข่ปลาสามจุด หน้าบทความจะเปลี่ยนสีจากสีเทา กลายเป็นสีด า หมายความว่า สามารถเลื่อนล าดับ
เนื้อหาได้แล้ว 

 
 

 

 

  

1 

2 
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3. ท าการคลิกค้างที่ปุ่มไข่ปลาสามจุด แล้วคลิกเมาส์เลื่อนล าดับเนื้อหาตามต้องการ 

 

 

การเซทการแสดงผลหน้าเนื้อหา 

          ในหน้าเนื้อหาที่เราสร้างนั้นระบบจะมีการแสดง รายละเอียดต่างๆ ไม่ว่าจะเป็นหมวดหมู่ ชื่อผู้เขียน
เนื้อหา วันท่ี ต่างๆ เราสามารถที่จะปิดส่วนต่างๆ นี้ได้ดังนี้ 

 

คลิกแล้วลากเมาส์เลื่อนตามต้องการ 
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1. ไปที่เมนู ระบบ > ตั้งค่าระบบหลัก 

 

2. คลิกที่ เนื้อหาทางด้านซ้ายมือ 
3. ท าการเปิด/ปิด หัวข้อต่างๆ ตามต้องการ 

 

2 

3 
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คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 50 
 
 

 

 ระบบเท็มเพล็ต Joomla สามารถจัดการระดับการเข้าถึงข้อมูล ไม่ว่าจะเป็น เนื้อหา , เมนู และโมดูล
ได้ โดยในระบบเท็มเพล็ต Joomla แบ่งประเภทของสมาชิกของเว็บไซต์ที่สามารถเข้าไปยังเว็บไซต์ได้ดังนี้ 

ประเภทสมาชิกในเว็บไซต์ 

 

 

ซึ่งในส่วนของสมาชิกประเภท Special ยังสามารถแบ่งออกได้เป็นสองส่วน 

กลุ่มท างานส่วนผู้ดูแลระบบ 

Manager        คือ สามารถเข้าส่วนผู้ดูแลระบบได้ แต่ไม่สามารถใช้งาน Component ได้ 
Administrator คือ สามารถเข้าส่วนผู้ดูแลระบบได้ ท างานได้ทุกอย่างแต่ไม่สามารถ เซทค่า Global  
                     Configuration ได้ 
กลุ่มท างานหน้าเว็บ 
Author          คอื สามารถเขียนบทความได้ แก้ไขบทความของตัวเองได้แต่ไม่สามารถเผยแพร่ได้ 
Editor           คือ สามารถเขียนบทความได้ แก้ไขบทความของคนอื่นได้ แต่ไม่สามารถเผยแพร่ได้ 
Publisher      คือ สามารถเขียนบทความได้ แก้ไขบทความของคนอื่นได้ สามารถเผยแพร่บทความได้ 

 

 

 

Part 5 : การจัดการสมาชิกและการก าหนดระดับการเข้าถึงเนื้อหา  

Public  = ทุกคน 

Guest  = กลุ่ม Guest 

Registered  = เฉพำะสมำชิก 

Speacial = ผู้มีหน้ำที ่

Super User = กลุ่ม ผู้ดแูล 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 51 
 

การเพ่ิมสมาชิกใหม่จากส่วนระบบผู้ดูแลระบบ 

1.ไปที่ค าสั่ง สมาชิก > การจัดการ > เพิ่มสมาชิกใหม่ 

 

2. กรอกข้อมูลสมาชิกให้ครบ โดยช่องที่มีเครื่องหมาย * ห้ามเว้นว่าง 

 

2.1 กรอกข้อมูลให้เรียบร้อย 
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3. จากนั้นคลิกที่แถบ เข้าอยู่ในกลุ่ม เลือกประเภท เป็น Registered จากนั้นคลิกปุ่มบันทึกและปิด 

 

        เม่ือเราก าหนดสมาชิกเรียบร้อยแล้วเราก็สามารถ ก าหนดได้ว่า เมนูใด เนื้อหาใด หรือโมดูลใด 

ให้เห็น หรือใช้งานได้เฉพาะสมาชิกเท่านั้น ได้ดังนี้ 

ท าการเปิดโมดลู Login สมาชิก 

การท าหน้าข้อมูลให้เฉพาะสมาชิกเข้าไปใช้งานได้นั้น จะต้องมี ส่วนท่ีสมาชิกใช้ในการ Login เข้าสู่ระบบ ซึ่ง
ในระบบ Joomla ได้มี โมดูล Login ให้เราสามารถตั้งค่าการใช้งานได้ วิธีการตั้งค่าโมดูล ล็อกอิน ท าได้ดังนี้ 
1. ไปที่ส่วนเสริม > โมดูล 

 

3.1 

3.2 

3.3 
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2. ค้นหาค าว่า Login ในช่องค้นหา 
3. เมื่อเจอผลการค้นหา คลิกเข้าไปท่ีโมดูลที่ชื่อว่า Login 

 

4. คลิกที่แถบการก าหนดการแสดงที่เมนู และก าหนดการแสดงผล เป็นทุกหน้า 

 

5. ก าหนดต าแหน่งที่จะวางโมดูล Login บนหน้าเว็บไซต์ 

 

 

 

 

2 
3 

4.1 

4.2 

เลือกเทมเพลต็ที่ใช้งำน 

เลือกต ำแหน่งที่ต้องกำร 
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จะปรากฏ โมดูล Login ที่หน้าเว็บไซต์ 

 

การสร้างเนื้อหา เฉพาะสมาชิก 

         1.ไปที่เมนู เนื้อหา > เนื้อหา > เพิ่มเนื้อหาใหม่ 

 
  2. พิมพ์เนื้อหาที่ต้องการ 

 

ตั้งชื่อเน้ือหาตามต้องการและเอเลียส์ตามต้องการ 

พิมพ์ข้อมูลตามต้องการ 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 55 
 
3. เมื่อพิมพ์ข้อมูลที่ต้องการเสร็จเรียบร้อยแล้ว เซทค่าทางด้านขวามือ 

 

 

** การเซทเมนูและโมดูลให้เฉพาะเข้าได้ ก็มีวิธีการเซทแบบเดียวกันกับท าเนื้อหาเฉพาะสมาชิก คือ

ตรงการเข้าถึง ให้เลือกเป็น Registered 

 

 
 Extension ในระบบเท็มเพล็ต Joomla คือ สว่นเสริมต่างๆ ที่ท าให้เว็บไซต์มีประสิทธิภาพในการ
ท างานมากขึ้น แบ่งประเภทของ Extension ต่างๆ ได้ดังนี้ 

โมดูล (Module) เป็นส่วนประกอบที่ใช้ในการแสดงผลในหน้าเว็บไซต์ เปรียบเสมือนกล่องแต่ละ
กล่อง หรือเป็นบล็อกที่สามารถแสดงผลติดต่อกับผู้ใช้ โดยโมดูลสามารถก าหนดต าแหน่งการแสดงผลได้ 
           คอมโพเน้นต์ (Component) เปรียบเสมือนซอฟแวร์ท่ีน ามาติดตั้งเสริมเพื่อร่วมกันท างานกับ 
Joomla เพื่อเพิ่มความสามารถให้กับเว็บไซต์ โดยคอมโพเน้นมีความซับซ้อนมากกว่าโมดูล โดยในการ
แสดงผลและส่วนปรับแต่ง ต้องปรับแต่งการท างานในหน้า Administrator ตัวอย่างเช่น Photo Gallery, 
Guest Book 
         ปล๊ักอิน (Plug In) เป็นส่วนที่เข้ามาเกี่ยวข้องในการติดต่อระหว่าผู้ชมและผู้ดูแลเว็บกับ Joomla 
ปลั๊กอินสามารถตรวจจับข้อมูลที่มาจาก Joomla ตัวอย่างเช่น editor – TinyMCE 
         เท็มเพล็ต (Template) คือส่วนแสดงรูปแบบของข้อมูลในหน้าเว็บไซต์ เช่น รูปร่างหน้าตา สีสัน 
กราฟฟิก เป็นต้น 

ท่านสามารถ ดาวน์โหลด extension ต่างๆ เพิ่มเติมตามต้องการได้ที่เว็บไซต์ 
http://extensions.joomla.org/ 

Part 6 :การใช้งาน Extension ต่างๆ  

เลือกสถานะ  

เลือกหมวดหมู่ คือ ให้เนื้อหาน้ีอยู่ในหมวดหมู่ใด 

การเข้าถึง ให้เราเปล่ียนเป็น Registered เพื่อให้
เฉพาะสมาชิกเข้าถึงเนื้อหานี้ได้เท่านั้น 

Registered 

http://extensions.joomla.org/
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การดาวน์โหลด Extension 
 1. http://extensions.joomla.org/ 

 

ผลลัพธ์ การค้นหา 

 

 

 

 

คลิกที่ extension ที่ต้องการ 

ค่าใชจ้่ายของ extension 

ใสช่ื่อ extension ที่ต้องการค้นหา 

เลอืก extension ตามประเภท 

http://extensions.joomla.org/


คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 57 
 

ตรวจสอบ extension ก่อนการดาวน์โหลด 

 

เมื่อคลิกปุ่ม Download แล้วเมื่อโหลดแล้วเราจะได้ไฟล์ extension ต่างๆ เป็น ไฟล์ zip มา 

วิธีการติดตั้ง Extension ใน เท็มเพล็ตเว็บไซต์ Joomla 

 1. ไปที่เมนูส่วนเสริม > การจัดการ > ติดตั้ง 

 

 

แสดงประเภทว่า extension 
น้ีเป็นประเภทใด 

Support กับ Joomla 
version ใด 

ดาวน์โหลด 

ดูตัวอย่างการท างาน 

Extensioon มีการอพัเดท 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 58 
 

2. คลิกที่แถบ อัพโหลดแพคเกจไฟล์  
3. คลิกที่ปุ่ม Choose File แล้วท าการเลือกไฟล์ที่ต้องการติดตั้ง 
4. จากนั้นคลิกปุ่ม อัพโหลด & ติดตั้ง 

 

5. จากนัน้รอจนกว่า ขึ้นติดตั้งส าเร็จเรียบร้อยแล้ว 
 6. เมื่อติดตั้งแล้ว extension ต่างๆ ที่ติดตั้งจะยังไม่ถูกเปิดใช้งาน เราจะต้องเข้าไปเปิดการใช้งาน 
extension ต่างๆ ด้วยตัวเอง โดยการไปท่ีเมนู ส่วนเสริม > โมดูล (extension บางตัวอาจจะเป็นปลั๊กอิน 
ดังนั้นต้องคลิกเลือกเมนู โมดูล > ปลั๊กอิน) 

7. ค้นหาชื่อโมดูลที่ต้องการ 

8. คลิกเปลี่ยนสถานะกากบาทสีแดง(ปิดการใช้งาน) ของ ส่วนเสริมนั้นให้เป็นเครื่องหมายถูก(เปิด
การใช้งาน) 

9. คลิกเข้าไปในชื่อของส่วนเสริม เพื่อเซทค่าต่างๆ ตามต้องการ 

         
 

2 

3 

8 9 

7 

4 
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การติดตั้ง Template (รปูต่างหน้าตาเว็บไซต์) 

Template คือ extension ชนิดหนึ่งของ Joomla เป็นรูปร่างหน้าตาของเว็บไซต์ สามารถดาวน์
โหลดได้ทั้งแบบฟรี และไม่ฟรี สามารถดาวน์โหลดเพิ่มเติมได้ที่ เว็บไซต์ joomla24.com หรือ ค้นหาจาก 
google ว่า template joomla 3 free 
 วิธีการดาวน์โหลด Template ในเว็บไซต์ Joomla24.com 

 

เมื่อท าการดาวน์โหลดเรียบร้อยแล้ว ให้ท าการติดตั้งเทมเพลตที่ดาวน์โหลด วิธีการติดตั้ง เทมเพล็ต 
จะเหมือนกันการติดตั้ง extension ทุกประการ  

การเปลี่ยนเท็มเพล็ต 
 ไปที่เมนูส่วนเสริม > เทมเพลต 

 

เวอร์ชั่น Joomla ที่ใช้ได ้

ตัวอยา่งเว็บไซต์เมื่อท าเสร็จแล้ว 

คลิกเพื่อดาวน์โหลด 
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รายละเอียดหน้าการจัดการเท็มเพล็ต(หน้าตาเว็บไซต์)  

 

 

การดูต าแหน่งต่างๆ ในระบบเท็มเพล็ต ที่จะสามารถวางโมดูลได ้

ในการจัดวางโมดูลต่างๆ บนเว็บไซต์นั้น เมื่อเราติดตั้งเท็มเพลตแต่ละตัวลงไปในระบบ Joomla นั้น 
แต่ละเทมเพลต จะมีต าแหน่งที่สามารถวางโมดูลได้ แตกต่างกัน เราสามารถดูต าแหน่งบนเทมเพล็ตต่างๆ ที่
จะวางโมดูลได้ ดังนี้ 

1. ไปที่เมนูส่วนเสริม > เทมเพลต 

 

 2. คลิกที่เมนูทางซ้ายมือ เทมเพลต 

 

รายชือ่เท็มเพลตทีม่ใีน
ระบบ 

หากเทมเพล็ตใดคลิกดาว
เหลืองหมายถึงใช้งานอยู ่ ประเภทของเท็มเพลต 

2 
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 3. คลิกเพื่อเปิด option ในการดูต าแหน่ง Template ไปที่ ตั้งค่าพื้นฐาน (ทางด้านขวามือ) 

 

 4. คลิกเปิด ในส่วนดูต าแหน่งโมดูล จากนั้นบันทึกและปิด 

 

5. คลิกที่ดูตัวอย่าง 

 
 

3 

4 

5 
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แสดงตัวอย่างต าแหน่งต่างๆ ที่จะวางโมดูลได้ 

 

การปรับแต่งค่าต่างๆ ในเท็มเพลต 
 1. ไปที่ส่วนเสริม > เทมเพล็ต 

 

 

 
 

รายชือ่ต าแหน่งในเทมเพล็ต 
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 2. คลิกไปในชื่อเท็มเพล็ตที่ต้องการ 

 
3. คลิกแถบขั้นสูง ท าการเซทค่าและบันทึก 

 
** แต่ละเท็มเพล็ตมีการเซทค่าไม่เหมือนกันดังนั้น เทมเพล็ตตัวที่ฟรี อาจจะมี option ในการเซทค่า 

น้อยกว่าเทมเพล็ตตัวที่เสียเงิน 

การวางต าแหน่งโมดูลต่างๆ บนเท็มเพลต 

เราสามารถน าโมดูลที่ติดตั้งแล้ว มาวางบนหน้าเว็บไซต์ได้โดยการก าหนดการแสดงโมดูลที่ต้องการ 
โดยการก าหนดหนดต าแหน่งของโมดูล 

1.ไปที่เมนู ส่วนเสริม > โมดูล 

 

2 
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2. คลิกเข้าไปในชื่อของโมดูลที่ต้องการเข้าไปเซทต าแหน่ง 

 

3 เลือกต าแหน่งทางด้านขวามือ เลือกต าแหน่งที่ต้องการ 

 

 4. คลิกแถบ การก าหนดการแสดงที่เมนู เลือกก าหนดการแสดงผล ว่าจะให้โมดูลนี้แสดงที่หน้าใด 

 

 5. จากนั้นกดปุ่มบันทึกและปิด 

5 

3 

ชื่อเทมเพล็ตที่ติดต้ัง 

ต าแหน่งต่างๆ ที่อยูบ่นเท็มเพลต 

แสดง/ซ่อน ชือ่โมดูล 

4 

4 
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การสร้าง Module ใหมต่ามต้องการ 

 1. ไปที่เมนู ส่วนเสริม > โมดูล 

 
 2. คลิกที่ปุ่มสร้างใหม่ 

 

โมดูลที่เซทค่าไว้จะแสดงขึ้นตาม
ต าแหน่งที่ต้องการ 

2 
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 3. เลือกประเภทโมดูลตามต้องการ ในที่นี่เลือก ก าหนด HTML เอง 

 
 4. ตั้งชื่อโมดูล และก าหนดค่าต่างๆ 

 

 

 

 

 

3 

ต้ังชื่อ โมดลู 
แสดงชื่อ/ซ่อนชือ่โมดูล 

ต าแหน่งที่จะวางโมดูล 

พิมพข์้อมูลต่างๆ 

ก าหนดว่าโมดูลจะแสดงที่หน้า
ใดบา้ง 
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ผลลัพธ์ 

 

การจัดเรียงต าแหน่งของโมดูล 

 ท่านสามารถสลับต าแหน่งของโมดูลที่อยู่ในต าแหน่งเดียวกันให้เรียงล าดับตามต้องการ 

 1. ไปที่ส่วนเสริม > โมดูล 

 

 2. คลิกปุ่มเครื่องมือค้นหา 

 3. เลือกต าแหน่งที่ต้องการจะเรียงล าดับโมดูล 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 68 
 

 
 

ผลลัพธ์การค้นหา 

 

 4. คลิกปุ่มสัญลักษณ์การสลับต าแหน่ง เพื่อให้จุดไข่ปลาหน้าชื่อโมดูลท างาน 

 5. คลิกที่สัญลักษณ์จุดไข่ปลา แล้วดึงโมดูลขึ้นลงสลับตามต้องการ 

 

 

2 3 

4 

5 
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วิธีการแก้ปัญหาโมดูลที่สร้างติดไปกับทุกหน้าเพจ 
           การที่เราจะท าข้อมูลเนื้อหา ให้แสดงแต่เนื้อหาของเราเพียงอย่างเดียว โดยไม่มีโมดูลอื่นติดมาด้วย 
นั้น เราจะต้องท าเมนู เชื่อมโยงเนื้อหานั้นให้หมด ซึ่งจะเป็นเมนู ด้านบน หรือ ด้านข้างก็ได้ 

           ในกรณีน้ี เมนูด้านบน หรือส่วนของ TOP ดั้งนั้น ต้องสร้างเมนูเชื่อมโยง ไปยังเนื้อหาที่ก าหนด
แสดงบนเว็บไซต์ 

 

 

 

 

 

เนื้อหำข่ำวกิจกรรม ซึ่งถูกเก็บอยู่

ในหมวดหมู่ข่ำวกิจกรรม 
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เมือ่ พิจารณาดูแล้วว่า เรามีการเชื่อมโยงไปยังเนื้อหา ที่อยู่ในหมวดหมู่ที่แสดงให้เห็นแล้ว เราต้องท า เมนู
ในส่วน TOP หรือเมนูด้านข้าง เพื่อ เชื่อมโยงข้อมูลในหมวดหมู่ของเนื้อหา ที่มีการเชื่อมโยงไว้ทั้งหมด เพื่อ
ให้ลิ้งค์ไปยังข้อมูลนั้นๆ โดยไม่มีโมดูลติดมาด้วย 

 

 

 

 

 

 

                                                                                       

                                                         ผลที่ได้ : จะมีโมดูลติดไปด้วยเสมอ 

แถบข่าวประกาศ ข้อมูลที่จะลิงคไ์ป

หา ไฟล์ PDF หรือเนื้อหาที่อยู่ใน

หมวดหมู่ข่ำวประกำศ 

แถบข่าวประกาศ ข้อมูลที่จะ

ลิงค์ไปหา ไฟล์ PDF หรือ

เนื้อหาที่อยู่ในหมวดหมู่ข่ำว

จัดซื้อจัดจ้ำง 

แถบข่าวประกาศ ข้อมูลที่จะลิงค์ไป

หา ไฟล์ PDF หรือเนื้อหาที่อยู่ใน

หมวดหมู่ข่ำวเด่นสหกรณ์ 

แถบข่าวประกาศ ข้อมูลที่จะลิงค์ไป

หา ไฟล์ PDF หรือเนื้อหาที่อยู่ใน

หมวดหมู่เกี่ยวกับสหกรณ์ 

แถบข่าวประกาศ ข้อมูลที่จะลิงค์ไป

หา ไฟล์ PDF หรือเนื้อหาที่อยู่ใน

หมวดหมู่ค ำสั่ง/ประกำศ 

แถบข่าวประกาศ ข้อมูลที่จะลิงค์ไป

หา ไฟล์ PDF หรือเนื้อหาที่อยู่ใน

หมวดหมู่แบบฟอร์มและคู่มือ 

โมดูล 

เมนูเว็บ 

มีการท าลิงคไ์ปยังเนื้อหาที่
เก็บอยู่ในหมวดหมู่  

ข่าวประกาศ 

ถ้าไม่ได้ท าเมนู
ลิงค์ไปหา
หมวดหมู่  

ข่าวประกาศ 

โมดูล 

เมนูเว็บ 

เนื้อหาที่ท าลิงค์ไป 
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สาเหตุเพราะ : ระบบ Joomla นั้น จะเชื่อมโยงข้อมูลเน้ือหาทุกอย่างด้วยเมนู เพื่อใช้ในการท า 

Sitemap ข้อมูลเนื้อหาทุกอย่างจะต้องเชื่อมโยงผ่านเมนูนั้นเอง หากเราไม่ได้ท าเมนูเชื่อมโยงเนื้อหา
ในเว็บมันจะถือว่า ข้อมูลนั้นเชื่อมโยงไม่สมบูรณ์ เลยท าให้มีโมดูลอื่นติดไปด้วย 

 

 

 

 

 

 

                                                                                       

ผลที่ได้ : จะมีมาแต่ข้อมูล 

ดั้งนั้นเมื่อพิจารณาจากข้อมูลแล้ว 

เราต้องสร้าง เมนูเชื่อมโยงไปยังหมวดหมู่ดังต่อไปนี้ 

1. หมวดหมู่ข่าวประกาศ 
2. หมวดหมู่ข่าวเด่นสหกรณ์ 
3. หมวดหมู่จัดซื้อจัดจ้าง 
4. หมวดหมู่ค าสั่ง/ประกาศ 
5. หมวดหมู่เกี่ยวกับสหกรณ์ 
6. หมวดหมู่แบบฟอร์มและคู่มือ 
7. หมวดหมู่เวียนฯ 

 

 

 

 

 

 

โมดูล 

เมนูเว็บ 

มีการท าลิงค์ไปยังเนื้อหาที่
เก็บอยู่ในหมวดหมู่  

ข่าวประกาศ 

ถ้ามีการท าเมนู
เชื่อมโยงไปยัง
หมวดหมุข่อง
เนื้อหานั้น 

เมนูเว็บ 

เนื้อหาที่ท าลิงค์ไป 
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วิธีการสร้างเมนู เราสามารถสร้างเมนู แม่และเมนูลูกได้ 

 

สามารถไปสร้างเพิ่ม ต่อจากเมนู สรุปข่าว ได้ 

การท าเมนูลูก ซึ่งทุกตัววิธีการสร้างเหมือนกัน เพียงแค่ต่างที่หมวดหมู่ที่จะเชื่อมโยงไป 

1. ไปที่ค าสั่ง เมนู > top เลือกเพิ่มเมนูใหม่ 
2. ตั้งชื่อลิงค์ตามต้องการ หรือตามตัวอย่าง ใส่แอเลี่ยส ให้สอดคล้องกับชื่อที่ตั้ง 

 

3. เลือกชนิดเมนู เป็นเน้ือหา > หมวดหมู่แบบ แสดงแบบลิสรายการ 

 

ข่ำวประกำศทั้งหมด 

ข่ำวเด่นสหกรณ์ทั้งหมด 

ข่ำวจัดซื้อจัดจำ้งทั้งหมด 

เกี่ยวกับสหกรณ์ทั้งหมด 

แบบฟอร์มและคู่มือ 

หนังสือเวียนทั้งหมด 

เชื่อมโยงไปยังหมวดหมูข่่ำวประกำศ 

เชื่อมโยงไปยังหมวดหมูข่่ำวเด่นสหกรณ์ 

เชื่อมโยงไปยังหมวดหมูข่่ำวจดัซื้อจัดจำ้ง 

เชื่อมโยงไปยังหมวดหมูเ่กี่ยวกับสหกรณ์ 

เชื่อมโยงไปยังหมวดหมูแ่บบฟอร์มและคู่มือ 

เชื่อมโยงไปยังหมวดหมูห่นังสือเวียนทัง้หมด 
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4. เลือกหมวดหมู่ข่าวประกาศ หรือหมวดหมู่ที่ต้องการ 

 
5. ท าการบันทึกและปิด ท าเพียงแค่นี้ ข้อมูลที่ลิงค์จาก TAB ต่างๆ ก็จะเชื่อมโยงไปยังเนื้อหา และไม่มี

โมดูลอื่นๆ ติดมาด้วย 

 

 

 

 

 

 

 

 

 

 

 

 

 

 

ข่าวประกาศ 
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1. Latest News Enhanced 

เป็น extension ที่ใช้ในการแสดงข่าวต่างๆ เช่นข่าวประชาสัมพันธ์ ข่าวกิจกรรมต่างๆ ของเว็บไซต์ 
โดย สามารถเซทค่าให้แสดงข่าวเองตามวันหรือรูปแบบที่ต้องการได้อย่างสะดวก สามารถดาวน์โหลด 
extension ได้ที่เว็บไซต์ https://extensions.joomla.org/extensions/extension/news-display/articles-
display/latest-news-enhanced 

1.1 เมื่อดาวน์โหลดเสร็จแล้วท าการติดตั้ง extension โดยไปที่เมนู ส่วนเสริม > การจัดการ > ติดตั้ง 
1.2 เมื่อท าการติดตั้ง ท าการเปิดการใช้งาน extension ไปที่เมนู ส่วนเสริม > โมดูล 

 
 1.3 ท าการเปิดการใช้งาน extension  

 

1.4 คลิกที่ Lastest News Enchanced เพื่อเข้าไปท าการเซทค่าต่างๆ 

1.5 คลิกที่แถบ Selection 

1.6 Data Source เลือก Articles 

1.7 Category เลือกเหมือนหมู่ที่ต้องการแสดง 

Part 7 :Extension ที่นา่สนใจ  

เปิดการใช้งาน 

https://extensions.joomla.org/extensions/extension/news-display/articles-display/latest-news-enhanced
https://extensions.joomla.org/extensions/extension/news-display/articles-display/latest-news-enhanced
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1.8 หัวข้อ Max Count ใส่ตัวเลข จ านวนหัวข้อที่ต้องการแสดงตามต้องการ 

 

1.9 คลิกที่แถบ Layout 

 

1.10 เลื่อนสกอล์บาร์ลงด้านล่าง ดูหัวข้อ LINKING 

1.11 หัวข้อ Link on เลือก Title 

1.6 

1.5 

1.7 

1.9 

1.8 
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1.12 หัวข้อ Link to เลือก Item in modal window 

 

 1.13 คลิกที่แถบ Body 

 

 1.14 เลื่อนสกอล์บาร์มาที่หัวข้อ TEXT 

 1.15 หัวข้อ TEXT introduction เลือก เป็น Meta Description 

 

 

 

 

 

 

1.10 

1.11 

1.12 

1.15 

1.13 

1.14 
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 1.16 คลิกที่แถบ การก าหนดการแสดงที่เมนู ว่าต้องการแสดงที่หน้าใดบ้าง 

 

 1.17 ก าหนดต าแหน่งการแสดงโมดูล ต าแหน่งที่ต้องการ 

 

ผลลัพธ์ที่ได้ 

 

 

 

1.16 

1.17 
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2. การใช้ Module Anywhere 

 เป็นโมดูลที่เราจะสามารถที่จะแทรก โมดูลต่างๆ ที่เราใช้งานลงในหน้าข้อมูลได้ตามต้องการ เรา
สามารถดาวน์โหลด Extension Module Anywhere ได้ที ่
https://extensions.joomla.org/extensions/extension/core-enhancements/coding-a-scripts-
integration/modules-anywhere ท าการติดตั้ง extension Module Anywhere ให้เรียบร้อย 

วิธีการใช้งาน Module Anywhere 

 2.1 ท าการเปิดเนื้อหาที่ต้องการแทรก โมดูล 

 2.2 คลิกที่ปุ่ม Module 

 

 2.3 เลือก โมดูลที่ต้องการแทรก 

 

 

2.2 

2.3 

https://extensions.joomla.org/extensions/extension/core-enhancements/coding-a-scripts-integration/modules-anywhere
https://extensions.joomla.org/extensions/extension/core-enhancements/coding-a-scripts-integration/modules-anywhere
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 2.4 เมื่อท าการแทรกโมดูลเสร็จจะมีโค๊ดการแทรกโมดูลเข้ามา 

 

3. การใช้เครื่องมือ TAB 

 สามารถดาวน์โหลดได้ที่ https://www.regularlabs.com/extensions/tabs ท าการติดตั้งให้เรียบร้อย 

เราสามารถใช้ TAB ร่วมกันการแทรกโมดูลต่างๆ เข้าไปใน TAB ได้ โดยใช้ Module Anywhere 

วิธีการใช้งาน TAB ร่วมกัน Module Anywhere 

 3.1 ไปที่ค าสั่ง ส่วนเสริม > โมดูล 

 3.2 สร้างโมดูลขึ้นมาใหม่ คลิกที่ปุ่ม สร้างใหม่ 

 

3.3 เลือก ก าหนด HTML เอง 

 

2.4 

3.2 

3.3 

https://www.regularlabs.com/extensions/tabs
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3.4 ตั้งชื่อโมดูล ในช่องชื่อ 

 

3.5  คลิกที่ปุ่ม Tabs อยู่ทางด้านล่าง 

 

3.6 จะปรากฎหน้าการใส่ข้อมูล TAB 

 

 

 

 

 

3.4
4 

3.5 
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3.7 ก าหนดค่าต่างๆ ใน TAB ดังนี ้

 

3.8 เมื่อกรอกข้อมูลหมดแล้ว คลิกที่ปุ่มแทรกสีเขียว 

 

3.9 จะได้ Code ของการแทรก TAB 

 

กรอกชื่อ TABข้อมูล 

คลิกให้ TAB นี้เป็น Default 

3.8 

TAB 1 

TAB 2 

TAB 3 
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3.10 ในส่วนของข้อความของคุณสามารถแทรก ข้อความที่ต้องการได้ หรือ แทรก Module ที่
ต้องการ หากแทรกโมดูลที่ต้องการสามารถแทรกได้ดังนี้ 

 

3.11 เลือก โมดูลที่ต้องการจะแสดงใน TAB 

 

 

 

แทรกโมดูลที่ต้องการตรงนี้ ท าการ

ลบข้อความออก แล้วคลิกที่ปุ่ม 

Module ด้านล่าง 

3.11 
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3.12 สคริปของ โมดูลที่จะแทรกจะปรากฏขึ้น 

 

3.13 ท าการเลือกการก าหนดการแสดงที่เมนู เลือกหน้าที่ต้องการแสดง 

 

3.14 เลือกต าแหน่งให้โมดูลที่สร้างขึ้นไปแสดงที่ต าแหน่งใด 

 

3.13 

3.14 
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ผลลัพธ์ที่ได้ 

 
 

การใส่สีให้ TAB 

{tab title="ข่าวประชาสัมพันธ์" class="blue"}  

+ ประกาศรับสมัครพนักงานราชการ ต าแหน่ง เจ้าหน้าที่บันทึกข้อมูล คลิกรายละเอียด 
+ ประกาศรับสมัครข้าราชการ ต าแหน่ง นักวิชาการสหกรณ์ปฏิบัติการ คลิกรายละเอียด 
 
{tab title="ข่าวประกาศ" class="green"} 

+ ประกาศปิดส านักงานช่วงเวลา 13.00-16.30 ในวันท่ี 22 กรกฏาคม 2560 คลิกรายละเอียด 

{/tabs} 

วิธีการพิมพ์ Code พิมพ์ค าว่า {tab title=”ชื่อแถบที่ต้องการต้ัง” class=”ชื่อสีภาษาอังกฤษ”} 
เช่น {tab title=”ข่าวจัดซื้อจัดจ้าง” class=”red”} 

**สีที่สามารถใช้งานได้มีดังต่อไปน้ี red , yellow , green , blue , gray 
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4. แสดงวิดีโอด้วย AllVideos 

 Allvideos เป็นปลั๊กอินที่ช่วยให้เราสามารถน าไฟล์วิดีโอต่างๆ มาแสดงบนเว็บไซต์ได้ไม่ว่าจะเป็น
ไฟล์ flv, swf, mov, mp4, wmv ,wma และ Youtube, Google Video ดาวน์โหลดได้ที่ 
https://extensions.joomla.org/extensions/extension/multimedia/multimedia-players/allvideos  

4.1 วิธีการใช้งาน ต้องท าการ Enable ปลั๊กอินก่อนใช้งาน โดยไปที่ 

 
       4.2 แก้ไขส่วน Local Video Floder เป็นท่ีอยู่ของไฟล์Video ที่เราเก็บไว้ 

 

 4.3. เมื่อเปิดปลั๊กอินและอัพโหลดไฟล์เรียบร้อยแล้วท าการแทรก TAGข้อมูล หากต้องการใส่ วิดีโอ
ในเนื้อหาใด ก็ท าการแทรก Tag code ลงไปในเนื้อหานั้น 

4.1 

4.2 

https://extensions.joomla.org/extensions/extension/multimedia/multimedia-players/allvideos
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ตัวอย่าง ต้องการแทรกไฟล์ Video ประเภท FLV ก็ท าการแทรกไปดังนี้ 

{flv}ชื่อไฟล์วิดีโอ{/flv}     เช่น  {flv}sample{/flv}      

หากเป็น Youtube สามารถแทรกได้ดังนี้  

          1. เปิดไฟล์ youtube ที่ต้องการน ามาแทรก  copy code รหัส Video มาแทรกในแท็กแสดงวิดีโอ
ดังนี้ 

 

  2. ท าการพิมพ์ข้อความลงในเน้ือหาที่ต้องการแสดง 

 

1 

2 
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{youtube}Qcly9NiNbmo{/youtube}  
หรือ {youtube}Qcly9NiNbmo|660|450|1{/youtube} 

หมายความว่า แสดง youtube ไฟล์นี้ โดยมีขนาดกว้าง 660 pixel และสูง 450 pixel และ 1 คือเล่นอัตโนมัติ 

ผลลัพธ์ 

 

 

5. Module นับจ านวนผู้เข้าเยี่ยมชมเว็บไซต์ Vinaora Visitors Counter 

 5.1 ดาวน์โหลด Module Vinaora Visitor Counter  แล้วท าการติดตั้งให้เรียบร้อย ดาวน์โหลดได้ที่ 
https://extensions.joomla.org/extensions/extension/site-management/analytics/vinaora-visitors-
counter  

 

1 

https://extensions.joomla.org/extensions/extension/site-management/analytics/vinaora-visitors-counter
https://extensions.joomla.org/extensions/extension/site-management/analytics/vinaora-visitors-counter
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         5.2 ท าการเปิด Module ที่ติดตั้งโดยการไปที่ ส่วนเสริม -> โมดูล 

         5.3 คลิกเข้าไปตั้งค่าที่ Vinaora Visitor Counter 

 

           5.4 ท าการเลือกต าแหน่งที่ต้องการแสดง Module นี ้

 

        5. ท าการก าหนดการแสดง Moduleที่หน้าใดบ้าง 
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ผลลัพธ์ 

 

 

Extension DJ-imageSlider  ส าหรับท าภาพสไลด ์

 1. เข้าเว็บไซต์ https://dj-extensions.com/dj-imageslider จากนั้น คลิก download 

 

        2. ท าการติดตั้ง Module DJ- ImageSlider ให้เรียบร้อย 

        3. จากนั้นเข้าไปจัดการ Module ที่ติดตั้ง ไปที่ ส่วนเสริม -> การจัดการโมดูล 

ผลลัพธ์ 

1 
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       4. คลิกเข้าไปท่ี DJ-imageSlider 

 

      5. เข้าไปจัดการเพิ่มรูปที่จะท าสไลด์ในระบบ โดยให้แสดงจากหมวดหมู่ที่เราสร้างไว้ สามารถท าได้โดย
คลิกไปที่  
         คอมโพเน้นท์-> DJ-ImageSlider 

 

            6.ท าการสร้าง Category ของสไลด์ ที่ต้องการ คลิกที่ Category 

 

 

3 

4 

5 

6 
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7. คลิกปุ่ม New เพื่อสร้าง Category ใหม ่

 

8. ตั้งชื่อ Category ที่ต้องการ  9.คลิก Save&Close 

 

10. คลิกที่ Slide เพื่อเพิ่มรูปภาพท า Slide 

 

 

 

 

 

8 
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11. ท าการตั้งชื่อ Title เลือก Category และ เลือกรูปที่ Slide Image โดยการกดปุ่ม Select 

 

12. คลิกเลือกรูป หากยังไม่มีรูปท่ีต้องการ คลิกปุ่ม เริ่มอัพโหลด เมื่ออัพโหลดรูปเสร็จเรียบร้อยแล้วคลิกปุ่ม
เพิ่มในเนื้อหา 

 

13. ต้องการท าลิงค์เลือก Link type และใส่ URL address ที่ต้องการ 

 

11.1 

11.2 

11.3 

13 

12.1 12.2 

12.3 
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14. เมื่อเสร็จแล้ว คลิก Save&Close 

 
15. ภาพสไลด์ก็จะปรากฎ หากต้องท าเพิ่มก็ท าตาม ข้อ 11 ได้ 

 
 

ท าการเซทค่าในการแสดงโมดูล Dj-image slideshow 

1. ไปที่เมนู ส่วนเสริม > โมดูล  
2. คลิกที่ DJ-ImageSlider 
3. Slide Source เลือก Component 

   

 

14 

15 

เลือก Component 

เลือก รูปแบบ Slide Type 

เลือก Link Images 

ให้น ารูปจากโฟลเดอร์ใดมาแสดง 
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เลือกจาก Category ที่ต้องการ 

ขนาดของสไลด์เต็มพื้นที่หรือไม่ 

เซทความกว้างตามต้องการ 

ให้แสดงทีละกี่รูปในสไลด์ 

จ านวนสูงสุดแต่ละสไลด์ 

เล่นอัตโนมัติหรือไม่ 

การหยุดและเล่นแบบใด 
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4. ท าการเซทค่าเพิ่มเติม และต าแหน่งที่จะแสดงบนเว็บไซต์ 

 

ผลลัพธ์ 

 

 

 

 

 

เลือกต าแหน่ง
แสดงผล 
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Extension Facebook Like box 
 เป็น Module ที่ใชก้ดไลท์แฟนเพจ ที่ตนเองอยากโปรโมท สามารถดาวน์โหลดได้จาก 
http://extensions.joomla.org/ 
          1.ดาวน์โหลดและติดตั้ง 

 
 2. ไปที่ ส่วนเสริม -> การจัดการโมดูล 

 
3.ท าการปิดการใช้งาน Module Facebook Likebox    4.คลิกเข้าไปจัดการโมดูล Facebook 

 

1 

2 

3 

4 
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5. เข้าไปจัดการ โดยใส่ URL FACEBOOK ที่ต้องการ 
6. ก าหนดขนาดที่จะแสดง 
7. ก าหนดต าแหน่งที่จะแสดง 

 
8. เลือกก าหนดหน้าที่จะแสดง    9.จากนั้นคลิกก าหนดการแสดงผล   10.จากนั้นคลิก Save&Close 

 

 

5 

6 

7 

8 

10 
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ผลลัพธ์ที่ได้ 

 

 

Extension Facebook Share Botton 

       1. ดาวน์โหลด Plugin Fast Social Share ได้จาก 
http://storejextensions.org/extensions/fast_social_share.html แล้วท าการดาวน์โหลดและติดตั้ง 

 

 

 

 

1 

http://storejextensions.org/extensions/fast_social_share.html
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     2. ท าการคลิกเข้าไปเพื่อเปิดการท างาน Plug In โดยไปท่ี ส่วนเสริม -> การจัดการปลั๊กอิน 

 

      3. คลิกเพื่อเปิดปลั๊กอินให้ท างาน  
      4. จากนั้นคลิกไปที่ปลั๊กอินเพื่อเข้าไปเซทค่า 

           
                      5. ท าการเซทค่าต่างๆ ตามต้องการ 

 

 

2 

3 

4 

5 

5 
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      6. ในส่วน FB ShareMe Button ท าการ Set เป็น Show    7.จากนั้นคลิก Save 

 

8. เรียกใช้ปลั๊กอินโดย เปิดเนื้อหาที่ต้องการ จากนั้นพิมพ์ค าว่า  {fastsocialshare}

 

6 

7 

8 
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ผลลัพธ์ที่ได้ 

 

 

Extension Simple Images Gallery ส าหรับท า Gallery ภาพ 
     1. คลิกดาวน์โหลด http://extensions.joomla.org/extensions/extension/photos-a-
images/galleries/simple-image-gallery และท าการติดตั้ง 
      *** ในการใช้ Plug In นี้ ท่านจะต้องท าการอัพโหลดรูปต่างๆ ใส่ในโฟลเดอร์ โดยอัพโหลด ใส่ใน
มีเดียก่อน  

 

1 

http://extensions.joomla.org/extensions/extension/photos-a-images/galleries/simple-image-gallery
http://extensions.joomla.org/extensions/extension/photos-a-images/galleries/simple-image-gallery
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2.ท าการเปิดใช้งาน Plug In ที่ติดตั้ง ไปที่ ส่วนเสริม -> การจัดการปลั๊กอิน 

  
3. คลิกเปิดใช้งานปลั๊กอิน Simple Image Gallery    4. คลิกเข้าไปแก้ไข 

 
          5. เลือก ไฟล์เดอร์ท่ีต้องการแสดงรูป Gallery และเซทค่าต่างๆ 

 
 

2 
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5 
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           6. เปิดเนื้อหาที่ต้องแทรก Gallery รูปภาพ    
           7. แทรก tag ลงไปดังนี้ {gallery}ชื่อโฟลเดอร์รูป{/gallery}  เช่น  {gallery}slider{/gallery} 

 

ผลลัพธ์ 

 

6 
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การใช้งานระบบ Webboard Kunena 

** ในการใช้ระบบเว็บบอร์ดนั้น เพื่อความปลอดภัยของเว็บไซต์จะติดตั้ง extension ที่ป้อง Spam 
ต่างๆ ที่จะเข้ามาก่อกวนเว็บไซต์ 

** ระบบเว็บบอร์ดน้ัน จะมีการเกี่ยวข้องกับระบบสมาชิกของเว็บไซต์ ที่เป็นผู้ดูแลเว็บไซต์ซึ่งเป็น
ผู้ดูแลเว็บบอร์ด 

การติดตั้ง extension Kunena 

ท่านสามารถดาวน์โหลด Extension ได้ที่ เว็บไซต์ http://web.cpd.go.th/webfaq 

โดยท าการติดตั้ง ตัวเว็บบอร์ด และ ติดตั้งภาษาของเว็บบอร์ด 

 

 

 

 

 

http://web.cpd.go.th/webfaq
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1. ไปที่ค าสั่งส่วนเสริม > จัดการ > ติดตั้ง 

 

2. คลิกที่ปุ่ม เลือกไฟล์ เพื่อท าการติดตั้ง เมื่อเลือกไฟล์เรียบร้อยแล้ว กดปุ่ม อัพโหลด&ติดตั้ง 

 

3. เมื่อท าการติดตั้งส าเร็จเรียบร้อยแล้ว ไปที่ ค าสั่ง คอมโพเน้นท์ > ระบบฟอรั่ม Kunena > แดชบอร์ด เพื่อ
เป็นการเข้าสู่หน้าหลักระบบเว็บบอร์ด 
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4. คลิกที่ หมวดหมู่ 

 

5. ท าการเพิ่มหมวดหมู่หรือแก้ไขหมวดหมู่ที่ต้องการ 

 

      5.1 หากต้องการสร้างหมวดหมู่ใหม่ ให้คลิกปุ่มหมวดหมู่ใหม่ สีเขียว 

 

 

คลิกหมวดเพื่อท ำกำรตั้งค่ำหมวด 

คลิกหมวดเพื่อท ำสร้ำงหมวดหมู่ใหม ่
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 5.2 ท าการก าหนดชื่อหมวดหมู่และรายละเอียด และท าการบันทึกและปิด 

 

หากต้องการลบหมวดบางหมวดที่ไม่ต้องการออกให้ท าการติ๊กถูก 
ด้านหน้าหมวดที่ไม่ต้องการแล้วคลิกที่ปุ่มลบ 

 

 

ก ำหนดว่ำจะให้อยู่ภำยใต้ฟอรั่มหลัก 

ตั้งชื่อหมวด 

ตั้งชื่อ Alias 

เผยแพร่เว็บบอร์ด 

ใส่รำยละเอียด 

ใส่รำยละเอียด 
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     5.3 เราจะได้หมวด ที่เราสร้างใหม่ จากนั้นท าการคลิกเข้าไปในหมวดหมู่ที่เราสร้างขึ้น 

 
 5.4 ก าหนดค่า ที่แถบ การเข้าถึงหมวดหมู่ 

 

คลิกเข้ำไปตั้งค่ำ 

ตั้งค่ำดังภำพ ให้เลือกเป็น 

Public เพ่ือให้ทุกคนเข้ำ

สู่เว็บบอร์ดได ้
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5.5 คลิกที่แถบ การตั้งค่าหมวดหมู่ ก าหนดค่าดังต่อไปนี้ จากนั้นกดปุ่ม บันทึกและปิด 

 

6. ก าหนด ผู้ใช้ ที่จะดูแลระบบเว็บบอร์ด 
      6.1 คลิกที่เมนูผู้ใช้งาน ทางด้านซ้ายมือ 
      6.2 คลิกที่ชื่อผู้ดูแลระบบท่ีต้องการ 

 
 

ตรวจสอบก่อนเผยแพร่ เลือกเป็น ใช่ 

เพื่อให้ผู้ดูแลระบบเป็นคนอนุมัติกระทู้ขึ้นเท่ำนั้น 

อนุญำตให้บุคคลทั่วไปโพสต์ได้ คือให้บุคคลทั่วไปที่

ไม่ใช่สมำชิก โพสกระทู้ต่ำงๆได้ 

ระดับกำรเข้ำถึงในกำรโพสข้อควำม เลือก บุคคลทั่วไป 

คือให้ทุกคนสำมำรถเห็นได้ 

6.1 

6.2 
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   6.3 คลิกที่แถบ การตั้งค่าในส่วนเป็นผู้ดูแลฟอรั่ม เซทค่าตามรูปคือ ให้ แอดมินคนนี้ ดูแลทุกหมวดหมู่ 
หากต้องการเลือกบางหมวดก็คลิกที่ชื่อหมวดหมู่ที่ต้องการ 

 

    6.4 ท าการกดปุ่ม บันทึกและปิด 

7. คลิกที่เมนูทางซ้ายมือ ตั้งค่าคอนฟิก  
       7.1 ก าหนดข้อมูลตามต้องการ หรือตามตัวอย่าง 

 

 

อีเมล์ของส ำนักงำน 

ข้อควำมเมื่อปิดเว็บบอร์ด 



คู่มือการใช้ระบบเวบ็ไซต์ Joomla 3.7x และ คู่มือการใช้งานโปรแกรม Photoshop หน้า 111 
 
     7.2 คลิกที่แถบความปลอดภัย ก าหนดค่าดังต่อไปนี้ 

 

   7.3 ท าการบันทึกและปิด 

 

8. ท าการสร้างเมนุ เพื่อเชื่อมโยงไปยังเว็บบอร์ด 
    8.1 ไปที่ ค าสั่ง เมนู > TOP > เพิ่มเมนูใหม่ 

 

คลิกแถบควำมปลอดภัย 
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 8.2 ตั้งชื่อเมนู เว็บบอร์ด และตั้ง เอเลียส์ webboard 

 

8.3 เลือกชนิดของเมนู เป็น  

 

8.4 เลือกรายการหลัก เป็น ฟอรัม  จากนั้นก็บันทึกและปิด 

 

 

เลือกเป็นระบบฟอรั่ม 

เลือก หน้ำแรก 

เลือกเป็น ฟอรัม 
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9. จะได้เมนู เว็บบอร์ดขึ้นมาเมื่อคลิกแล้วจะเข้ามาสู่หน้าหลักของเว็บบอร์ด 

 

    9.1 สามารถตั้งกระทู้ได้โดยคลิกที่ปุ่ม ตั้งกระทู้ใหม่ 

 

 

 

เมนูเว็บบอร์ด 

ผู้ใช้ทั่วไปสำมำรถคลิกเข้ำหมวด

เพื่อตั้งกระทู้ได้ 

คลิกเพ่ือตั้งกระทู้ 
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   9.2 ตั้งกระทู้ตามต้องการ เมื่อเสร็จเรียบร้อยแล้วกดปุ่ม ส่งข้อความ 

 

 

 9.3 กระทู้จะเข้าสู่ระบบ แต่ยังไม่ปรากฏที่หน้าเว็บไซต์ เพราะ ผู้ดูแลระบบจะท าการอนุมัติขึ้นก่อน 

 

 

ตั้งกระทู้ตำมต้องกำร 

คลิกเพื่อตั้งกระทู ้
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ผู้ดูแลเว็บบอร์ด เข้าสู่ระบบเว็บบอร์ด เพื่อ อนุมัติกระทู้ 
1. คลิกเข้าสู่ระบบ เพื่อล็อกอินเข้าสู่ระบบ 

 

2. เมื่อล็อกอินเข้าสู่ระบบ จะเห็น กระทู้ที่รอการอนุมัติ สามารถคลิกเข้าไปดูข้อมูลได้ 

 

3. เมื่อเข้ามาดูแล้ว หากต้องการลบข้อมูลบางส่วน คลิกที่การดูแล และเลือกลบ 

 

คลิกเพ่ือเข้ำไปดูรำยละเอียด 

ส่วนที่จะลบ 

คลิกออกจำกระทู้ เพื่อไปส่วนกำรอนุมัติ 
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4. ท าการ ติ๊กเลือกกระทู้ที่ต้องการ อนุมัติ หรือลบกระทู้ แล้วคลิกเลือก ว่าจะจัดการอย่างไร 

 

5. เมื่อมีการอนุมัติแล้วกระทู้ไปปรากฏบนเว็บบอร์ดแล้ว หากมีคนเข้ามาตอบในกระทู้ที่อนุมัติแล้ว ผู้ดูแล
เว็บบอร์ด ท าการล็อกอินเข้าไปอนุมัติค าตอบได้ดังนี้  

     5.1 ท าการคลิกเข้าไปในกระทู้น้ัน  
     5.2 ด้านล่างข้อความที่ตอบ คลิกการดูแล เลือก ตรวจสอบผ่านอนุญาตให้น าเสนอ 

 

ติ๊กเลือกกระทู้ที่ต้องกำร 

หำกต้องกำรอนุมัติ เลือก ตรวจสอบกระทู้แล้ว 

หำกต้องกำรลบ เลือก ลบกระทู้ที่เลือก 

คลิกที่ปุ่ม ไปเพื่อยืนยัน 
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การออกจากระบบ ผู้ดูแลเว็บบอร์ด  

 

 

การท า Site Map 

** การท า Site Map อาจจะมีบางส่วนที่ผู้บริหารเว็บไซต์ต้องจัดการเรียงข้อมูลเองในบางส่วน 

1 ท าการติดตั้ง extension OS map Free 
2 โดยไปท่ี เมนูส่วนเสริม > การจัดการ > ติดตั้ง 

 

คลิกที่สัญลักษณ์ 
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3. ท าการติดตั้ง extension Os map Free 

 
4. เปิดการท าการ plugin Os map Free 

 
5. ไปที่เมนู คอมโพเน้นท์ เลือก > OSMap Free 
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6. คลิกที่ปุ่ม สร้างใหม่ 

 
7. ท าการตั้งชื่อใน ช่อง Name และท าการคลิกเลือก กลุ่มเมนู ที่ต้องการท า Sitemap จากนั้นกดปุ่ม 
บันทึก&ปิด 

 
8. คลิกค าว่า html เพื่อดูตัวอย่าง Sitemap 

 

9. จะเปิดหน้าเพจที่เป็น sitemap ให้เรา 

6 

7.1 

7.2 

7.3 

8 
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10. ท าการไฮไลท์ Sitemap ที่ได ้และ copy 

 
11 . ท าการสร้างเนื้อหาขึ้นใหม่ เพื่อวางข้อมูล Sitemap ที่ copy มา และท าการแก้ข้อมูลโดยการเรียงข้อมูล
ตามหัวข้อที่ต้องการ 
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12. ท าการสร้างเมนู ลิงค์ไปยังเนื้อหา ที่เป็นแผนผังเว็บไซต์ตามต้องการ หากมีการเปลี่ยนลิงค์เมนูใหม่ ก็
ท าการสร้างลิงค์ sitemap ใหม่ ตามข้อ 6  

การป้องกันเว็บไซต์เบ้ืองต้น โดยใช้ JHack Guard 

             ทางศูนย์เทคโนโลยีสารสนเทศและการสื่อสาร ได้ท าการติดตั้ง extension ที่ป้องกันการ Hack 
เว็บไซต์ ไว้เบื้องต้นแล้วบนเว็บไซต์ของท่าน ขอให้ท่านตรวจสอบ ว่าได้ท าการเปิดการใช้งาน extension ให้
ท าการเพื่อป้องกัน 

วิธีการตรวจสอบ  

1.ไปที่เมนู ส่วนเสริม > ปลั๊กอิน 
2. ค้นหาค าว่า jh ในช่องค้นหา 
3. ท าการเปิดการใช้งาน Extension JHackGuard Plugin ให้เป็นเครื่องหมายถูก (เปิดการใช้งาน) 

 

1. 2. 

3. 
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หากยังไม่ได้ท าการติดตั้ง ท าการ ดาวน์โหลด Extension ได้ที่ 
http://web.cpd.go.th/cpdfaq/images/JHackGuard.zip 

ท าการติดตั้ง Extension 
1. ไปเที่เมนู ส่วนเสริม > การจัดการ > ติดตั้ง 

 
 

2. คลิกที่ปุ่มเลือกไฟล์ ท าการเลือก JHackGuard.zip ที่ท าการดาวน์โหลดไว้ 

 

 

 

 

 

 

2.1 

2.2 

2.3 

http://web.cpd.go.th/cpdfaq/images/JHackGuard.zip
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3. กดปุ่มอัพโหลด&ติดตั้ง 

 
รอจนกว่าจะขึ้นข้อความว่า ติดตั้งแพคเกจ เสร็จสมบูรณ์แล้ว 

 

เมือ่ท าการติดตั้งเสร็จเรียบร้อยแล้ว ท าการเปิดการใช้งาน ตามวิธีการตรวจสอบ ในหน้าแรก 

 การบริหารการจัดการไฟล์ข้อมลูบนเว็บไซต์ 

 1. คลิกที่สัญลักษณ์ Joomla 
 2. คลิก มีเดีย 

 

1 

2 
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สร้าง โฟลเดอร์ใหม่ 

 

อัพโหลดไฟล์ 

 

 

 

 

 

 

คลิก 

ตั้งชื่อโฟลเดอร์ 

คลิกปุ่มสร้างโฟลเดอร์ 

คลิก 

คลิกปุ่ม Choose Files 

คลิกปุ่มเริ่มอัพโหลด 
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การลบไฟล์ 

 

การท าหน้าต้อนรับหรือ Popup ก่อนเข้าหน้าเว็บไซต์ 

 

คลิกเลือกไฟล์ที่ต้องการ 

คลิกปุ่มลบ 
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วิธีการอัพโหลดไฟล์ที่มีขนาดใหญ่และไม่สามารถอัพโหลดขึ้นในระบบได้ 

 ในการอัพโหลดไฟล์ที่มีขนาดใหญ่นั้นทางระบบ Joomla นั้นจะอนุญาต ให้ท่านอัพโหลดไฟล์ได้ไฟล์
ละไม่เกิน 2 mb หากไฟล์นั้นมีขนาดเกิน 2 mb ขึ้นไปต้องท าการอัพโหลดขึ้น google drive ของส านักงาน 

 วิธีการใช้ google drive  

 1. เข้าเว็บไซต์ google.co.th 

 

1 
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2. ท าการล็อกอินเข้าสู่ระบบ 

 

3. ท าการคลิกที่สัญลักษณ์ เปิดแอป  
4. จากนั้นคลิกที่ Drive 

 

 

 

3 

4 
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5. จะเข้ามายังไดรฟ์ของเรา ท าการคลิกปุ่ม New เพื่อท าการอัพโหลดไฟล์ใหม่ 

 

6. เลือก File upload และท าการเลือกไฟล์ที่ต้องการ 

 

7. รอจนกว่าอัพโหลดเสร็จสิ้น 

 

5 

6 
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8. เมื่ออัพโหลดเสร็จสิ้นต้องการน าไฟล์มาใช้งาน เราจะต้อง copy ลิงค์ไฟล์ใน google drive โดยการคลิก
ขวาที่ ไฟล์ที่ต้องการ 

9. เลือก Get Shareable link 

 

10. ท าการ copy ลิงค์ไฟล์ทีไ่ด้ ไปท าการเชื่อมโยงไฟล์ในเว็บไซต์ 

 

 

8 9 

10 
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คู่มือการท าหัวเว็บไซต์และการตกแต่งภาพเบื้องต้น โดย Photoshop 

ส่วนประกอบต่างๆ ของหน้าจอของโปรแกรม Photoshop 

 

 

 

 

Title Bar แสดงชื่อ Program 

Menu Bar การใชง้านค าส่ังต่างๆ 

Option Bar จะเปล่ียนตาม Tool ที่เลือก 

Tool เครื่องมือการใชง้าน 

Windows ที่ถูกซ่อน 

Windows เครื่องมือต่างๆ 

วิธีการใช้ History ย้อนกลับการกระท าที่ผิดพลาด สามารถเล่ือนกลับ

ได้โดยคลิกย้อนกลับขึ้นไปทีละการกระท าตามต้องการ แตก่าร

ย้อนกลับ History มีข้อจ ากัดคือ ย้อนกลับได้ไม่มา ดงันั้นการท างาน

กับโปรแกรม Photoshop ควรระมัดระวงัในการท างาน 
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วิธีการท าหัวเว็บไซต์ 

1. สร้างพื้นที่การท างาน เพื่อสร้างหัวเว็บไซต์ โดยไปค าสั่ง File > New  หรือ Ctrl+N 

 

 

2. ก าหนดพื้นที่การท างานที่จะสร้างส่วนหัวของเว็บไซต์ โดยก าหนดขนาดตามตัวอย่าง แล้วกดปุ่ม OK 

 

1. 

ก ำหนดขนำดต่ำงๆ หนว่ยเปน็ pixels 
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3. จะได้พื้นที่การท างานที่เราก าหนดขึ้นโดยมีรายละเอียดดังนี้ 

 

4. ท าการลงสี โดยการไล่ระดับสีที่ต้องการโดยใน Tool Gradiant  (ถูกซ่อนอยู่ใน Tool สัญลักษณ์ รูปถังสี) 

 

 

แถบสลับชื่อไฟลต์่ำงๆ ทีท่ ำงำนอยู ่

พื้นที่กำรท ำงำน 
Layer กำรท ำงำน 

4.1 ท ำกำรคลกิเลอืก Tool 

Gradient Tool 

4.2 ท ำกำรคลกิเลอืกสี 

Foregroud color และ 
Background color 

4.3 ท ำกำรคลกิสทีี่ตอ้งกำร

ทั้ง Foreground และ 
Background 
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5. เลือก Option Bar ตามความต้องการ 

 

 

6. ท าการคลิกค้าง จุดเร่ิมต้นแล้วลากให้เกิดเส้น 

 

 

7. ท าการพิมพ์ข้อความลงพื้นที่การท างาน โดยใช้ Type Tools 

                     

5.1 เลือกแบบสกีำรไล่ระดับทีต่้องกำร 

5.2 เลือกลกัษณะกำรไล่ระดับสี 

5.3 เลือก Mode กำรท ำงำน Normal 

6.1 จุดเร่ิมต้น 

6.2 จุดสิน้สดุ 

ผลลัพธ ์

คลิกที่ Type Tool คลิกเมำส์ให้เกิด Cursor ตรงจุดทีต่้องกำร ให้เกิด 

Cursor กระพริบๆ 
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8. พิมพ์ข้อความที่ต้องการลงพื้นที่การท างาน 

 

 

 

9. ท าการใส่ Effect ให้กับ Layer ตัวอักษรให้ดูเด่นขึ้นโดยการใส่เส้นขอบตัวอักษร  

โดยไปที่เมนู Layer> Layer Style>Stroke 

 
 

 

ได้ Layer ของชื่อ

หนว่ยงำน 

9.1 ไปที่  
Layer>Layer Style>Stroke 

9.2 ขนำดของเสน้ขอบ 

9.3 สีของเสน้ขอบ 

แบบอักษร หนำ/เอียง ขนำด จัดวำง สี ข้อควำมศิลป ์ ยืนยัน ควำมคมชัด 
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10. ท าการย้ายข้อความไปยังต าแหน่งที่ต้องการโดยใช้ Move Tool หรือ arrow key (ลูกศรบนแป้นลูกศร

บนคีย์บอร์ดเลื่อนข้อความได้) 

 

11. ท าการเปิดไฟล์ตราสัญลักษณ์ที่ต้องการเข้ามายังโปรแกรม Photoshop โดยไปที่ค าสั่ง File > open 

หรือ CTRL+O 

 

9.3 เงำของตัวอักษร (Drop Shadow) 

11. เปิดไฟล์ภำพท่ีต้องกำร  
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12. ได้ไฟล์รูปที่ต้องการจากนั้นเลือก เครื่องมือ Selection เพื่อท าการเลือกบางส่วนของรูปภาพไปยังพื้นที่

การท างานของเรา 

 

 

11.1 เลือกรูปที่ต้องกำรแล้ว คลิก Open  

12.1 แถบแสดงพื้นที่กำรท ำงำน

และไฟล์รูปที่เปิดขึ้นมำ สำมำรถ

คลิกสลับกำรท ำงำนได้ 

12.2 เลือกเครื่องมือ Marquee Tool 

ที่เหมำะสมกับงำน 
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13. ในที่นี่ ตรากรมเป็นลักษณะของวงกลมที่ตายตัวแน่นอน ก็ใช้ Selection Marquee Tool ที่เป็นวงกลม 

เม่ือคลิกแล้ว เมาส์จะเปล่ียนเป็นเครื่องหมาย + จากน้ันคลิกเมาส์ค้างลากคลุมสัญลักษณ์ 

 

* หากลากเส้นประแล้วไม่ครอบคลุมส่วนท่ีต้องการ สามารถยกเลิกได้โดยการคลิกเมาส์นอกเส้นประเส้นประก็จะ

หายไป แล้วท าการลากใหม่ 

** สามารถ กด Shift ค้างไว้เพื่อให้วงกลมเส้นประ มีความกลมไม่เบี้ยว 

การเลือกใช้ เครื่องมือ Selection ต่างๆ แต่ละเครื่องมือนั้นตอ้งพจิารณาถึงรูปร่างๆของรูปภาพท่ีตอ้งการเป็นหลัก  

1.รูปต่างทีเ่ป็นรูปทรงแน่นอนเช่น รูปลักษณะ วงกลม ส่ี เหล่ียม ใชเ้ครื่องมือ

 

2. รูปทรงที่ไม่ตายตัวแน่นอน เชน่ รูปคน หรือส่ิงของ ใช้เครื่องมือ 

 

13. จุดเริ่มต้นลำกเส้น selection 

+ 
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14. เมื่อลากเส้น selection ได้แล้ว ท าการคัดลอกรูปภาพเพื่อน าไปวางยังพื้นที่การท างานของเรา โดยการ ไปที่

เมนู Edit > Copy หรือ CTRL+C 

 

15. กลับไปยังพื้นที่การท างาน แล้ว วางรูปภาพที่คัดลอก โดยการไปท่ีเมนู Edit>Paste  

 

 

รูปภาพที่ท าการคัดลอกแล้วน ามาวางในพื้นที่การท างาน 

 

 

 

 

 

Edit > Copy หรือ CTRL+C 

Edit > Paste หรือ CTRL+V 

15.1 สลับกลับพื้นที่กำรท ำงำน  

โดยคลิกที่ชื่อพื้นที่กำรท ำงำน 
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16. เม่ือท าการวางรูปภาพที่คัดลอกแล้ว จะเกิดภาพที่ขนาดใหญ่หรือเล็กกว่าที่ต้องการสามารถ ขยาย 

หรือลด ขนาดรูปในพื้นที่การท างานได้ โดยไปที่ เมนู Edit > Free Transform หรือ CTRL+T 

 

 

 

 

 

เม่ือย่อรูปได้ตามต้องการแล้ว กดเครื่องหมาย ถูก ด้านบน เพื่อยืนยันการลดขนาดรูปภาพ 

 

 

 

Edit > Free Transform หรือ CTRL+T 

สำมำรถดึงหมุดยึดเพื่อขยำยหรือ

ย่อได้ ตำมต้องกำรและสำมำรถ

ย้ำยรูปได้ตำมต้องกำร 

หำกดึงหมุดยึดตรงมุมออกจะเป็นกำรขยำย 

หำกดึงหมุดยึดตรงมุมเข้ำจะเป็นกำรย่อ 

คลิก ถูก เพื่อยืนยันกำรเปลี่ยนแปลง 
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17. ท าการใส่เส้นขอบหรือเงา ตามต้องการวิธีการท าตามข้อ 9. 

18. น ารูปภาพมาตกแต่งส่วนที่ว่างในพื้นที่การท างาน โดยการเปิดภาพที่ต้องการเข้ามาในโปรแกรม 

Photoshop  วิธีการเปิดภาพดูได้ที่ข้อ 11. 

 

19.การน ารูปภาพไปทั้งหมด ท่านสามารถใช้ คีย์ลัด คือ CTRL+A หรือ Select > A ก็ได ้

 

20. ท าการ Copy รูปที่ต้องการเพื่อน าไปวางยังพื้นที่การท างาน โดยการกด CTRL+C หรือ Edit>Copy 

21. กลับมายังพื้นที่ท างาน แล้ววางรูปที่ Copy  ลงบนพื้นที่การท างาน  โดยการกด CTRL+V หรือ 

Edit>Paste 

 

** ท าการย้ายต าแหน่งรูปภาพไปไว้ตามที่ต้องการ โดยใช้ Move Tool 
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หากต้องการย้าย ลบ หรือจะตกแต่ง Effect ใดๆ กับรูปนั้นจะต้องทราบก่อนว่า วัตถุต่างๆ น้ันอยู่ใน 

Layer อะไร จะต้องท าการเลือก Layer นั้นก่อน ถึงจะกระท ากับ Layer นั้นได้ 

                        

22. ท าการลบบางส่วนของรูปภาพ ใช้ Tool ที่เป็นรูปยางลบ หรือ eraser  tool 

 

ดูที่แถบ Option Bar ของ Eraser จะมีหัวขนาดยางลบ ให้เลือกตามความเหมาะสมของรูปภาพ 

รำยชื่อ Layer ที่อยู่ในพื้นท่ีกำรท ำงำน 

แสดงหรือไม่แสดงบนพ้ืนที่กำรท ำงำน ปิดตำคือไม่

แสดง เปิดตำคือแสดง 

ลบ Layer ที่ต้องกำร โดยกำรคลิกเลือก layer ที่ต้องกำร

แล้วคลิกรูป ถังขยะ 

สร้ำง Layer ใหม่คลิกที่รูปกระดำษ 

สร้ำง ส ำเนำ Layer ที่

เหมือนกันให้ คลิก layer ที่

ต้องกำร แล้วลำกส์ไปหำ

สัญลักษณ์รูปกระดำษ 

คลิกที่ Tools Eraser  
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* หัวยางลบมีหลายแบบให้เลือกใช้ ใช้เลือกใช้แบบใดก็ได้ที่ เป็นแบบ Soft Round 

 

คลิกลบที่รูปภาพ ภาพที่ลบก็จะจางลงไปเรื่อยๆ กลมกลืนกับพื้นหลัง 

 

23. ปรับความเข้มและจางของภาพให้กลมกลืน โดยคลิกปรับที่ค่า Opacity ของ Layer รูปภาพตกแต่ง 

 

 

 

เลือกแบบ Soft Round และขนำดหัวยำงลบตำมต้องกำร 

คลิกเลือก Layer ที่ต้องกำรปรับควำมเข้มจำง แล้วเลือก 

Opacity ตำมต้องกำร ย่ิงตัวเลขน้อย ควำมจำงของรูปภำพก็

จะจำงมำกขึ้น 
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ผลลัพธ์ที่ได้ 

 

 

24. การบันทึกเพื่อน าไปใช้งานบนเว็บ และ บันทึกเพื่อกลับมาแก้ไขในภายหลัง 

 การเซฟเพื่อไปใช้งานบนเว็บไซต์ ไปที่ เมนู File > Save for web & devices เลือกประเภทไฟล์ตาม

ต้องการตามภาพ แล้วกดปุ่น Save 

 

เลือกประเภทไฟล์ที่ต้องกำร แบบ Jpeg , GIF หรือ PNG 

คุณภำพของไฟล์ยิ่งมำก ขนำดไฟล์ยิ่งเพิ่มขึ้น 
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 การบันทึกเพื่อน ากลับมาแก้ไขได้ในภายหลัง เมื่อบันทึกแล้วจะได้ไฟล์นามสกุล .psd ซึ่งเป็น

นามสกุลไฟล์ของ Photoshop 

                    

 

 

เลือกไดรฟ์ที่ต้องกำรบันทึก 

ตั้งชื่อไฟล์เป็นภำษำอังกฤษ 

เลือก Format เป็น Images Only 

จำกนั้นคลิก Save 

 

เลือกไดรฟ์ที่ต้องกำรบันทึก 

ตั้งชื่อไฟล์เป็นภำษำอังกฤษ 

เลือก Format เป็น Photoshop 

จำกนั้นคลิก Save 
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การสร้าง Banner กระพริบ 

วิธีการสร้างแบนเนอร์กระพริบน้ัน เพื่อให้ผู้ใช้สังเกตุแบนเนอร์ของเราได้ง่ายและสะดวกต่อการเข้าถึง

ข้อมูลสามารถท าได้ดังนี้ 

1. สร้างพื้นที่แบนเนอร์ขนาดที่ต้องการ ตามตัวอย่างคือ 170*60 pixel 

 

2. ท าการตกแต่งสีพื้นหลังตามต้องการเหมือนกับการท าหัวเว็บไซต์ 

 

3. ท าการพิมพ์ข้อความที่ต้องการลงไปในพื้นที่การท างาน 

 

4. ท าการเติม effect ให้กับตัวอักษร โดยการเติมเส้นขอบ (Stroke) เป็นสีที่ต้องการ 
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5. เร่ิมสร้าง ภาพเคลื่อนไหว หรือ Animation โดยการเรียกแถบเครื่องมือขึ้นมา โดยไปที่ 

Windows>Animation 

 

จะได้แถบการท าภาพเคลื่อนไหวขึ้นมา ท าการเปล่ียนแถบท าภาพเคลื่อนไหวเป็นแบบโหมด Frame 

Animation 

 

จะได้แถบ แบบน้ี 

 

ส่วนประกอบของ Windows Animation 

 

 

คลิกเพื่อเปลี่ยนโหมด 

เฟรมกำรท ำงำน 

ก ำหนดเวลำ

กำรเปลี่ยน

เฟรม 

ควบคุมกำรเล่น 

สร้ำงเฟรมใหม่ ลบเฟรมที่ต้องกำร ก ำหนดรอบกำรเล่น 
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6. ก าหนดจ านวนเวลาที่จะเปลี่ยนเฟรมการเล่นโดยการคลิกที่ ตัวเลข sec 

 

7. ท าการก าหนดรอบการเล่นของ animation 

 

8. ท าการสร้างเฟรม ถัดไปโดยการคลิกสัญลักษณ์จะได้เฟรมใหม่ขึ้นมาอีก 1 เฟรม 

 

 

 

 

 

เลือกเฟรมที่ต้องกำรและจ ำนวน

วินำทีท่ีจะเปลี่ยนเฟรม 

เลือกเป็น Forever เพื่อให้แสดง

วนรอบไปเรื่อยๆ 

คลิกที่สัญลักษณ์จะได้เฟรมใหม่

ขึ้นมำอีก 1 เฟรม 
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9. ท าการเปล่ียนสีเส้นขอบที่ต้องการโดยดับเบ้ิลคลิกเลือกเปล่ียนสีที่ effect Stroke 

 

จะได้เส้นขอบอีกสีหนึ่งในเฟรมที่ 2 

 

** หากต้องการเปล่ียนอีกหนึ่งสี ก็สามารถเพิ่มเฟรมที่ 3 แล้วเลือกเฟรมที่ 3 และท าการเปลี่ยนสีเส้นขอบ

ตามข้อ 8 ซ้ าไปเรื่อยๆ  

10. ท าการคลิกปุ่ม Play เพื่อเล่น Animation จะเล่นเปลี่ยนสีไปเรื่อยๆ  

 

ดับเบิ้ลคลิกที่ Stroke 

เปลี่ยนสีที่ต้องกำร แล้ว

กด OK 

คลิกที่ปุ่ม Play 
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11. ท าการเซฟน าไปใช้บนเว็บไซต์ โดยการไปที่ เมนู File>Save for Web & Device ต้องเลือกประเภทไฟล์

เป็น GIF เท่าน้ันจึงจะเล่น Animation ได้ 

 

 

การสร้างกรอบรูปภาพบุคลากรหรือกรอบต่างๆ 

1. สร้างพื้นที่การท างานขึ้นมาขนาดตามต้องการหรือเปิด Background รูปที่ต้องการ 

 

 

 

 

 

เลือกประเภทไฟล์ GIF 
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2. ท าการวาดเส้น section แบบสี่เหลี่ยม ในลักษณะตามรูป 

 

3. ท าการเปิดรูปบุคลากรขึ้นมาในโปรแกรมไปที่ File>Open เลือกรูปบุคลากรที่ต้องการและท าการเลือก

ทั้งหมดของรูปภาพบุคลากรโดยเลือกค าสั่ง Select>All 

           Select All          

4. ท าการ copy รูปบุคลากรที่ต้องการโดยไปที่ Edit>Copy หรือ CTRL+C 

5. กลับมายังพื้นที่การท างาน จากน้ันเลือกค าสั่ง Edit>Paste Special>Paste into 
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จะได้รูปตามภาพ 

 

6. ใช้ Move Tool ท าการเคลื่อนย้ายรูปไปไว้ในต าแหน่งที่ต้องการ หรือ ถ้ามีขนาดใหญ่หรือเล็กเกินไปก็

ท าการใช้ค าสั่ง Edit>Free Transform ในการลดขยายขนาดรูป 

 

 

คลิกเพื่อจัดกำรกับรูปภำพ เช่น เลื่อน ย่อ ขยำย 

คลิกเพื่อเลื่อนกรอบใส่รูปภำพ 
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7. จะได้กรอบรูปภาพดังภาพ จากนั้นท าการเซฟเพื่อน าไปใช้งานโดยการไปที่เมนู File>Save for Web & 

Devices 

 

การลดขนาดรูปภาพเพื่อใช้งาน 

1. เปิดไฟล์ภาพที่ต้องขึ้นมาที่มีขนาดใหญ่ไม่สามารถลงในเว็บไซต์ได้ 

2. ไปที่เมนู Image > Image Size 

 

 

 

ถ้ำมีเครื่องหมำยลูกโซ่หมำยถึงกำรลด

ขนำดให้มีควำมสัมพันธ์ทั้งสองด้ำน 
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3. จะได้ไฟล์ใหม่ที่มีขนาดเล็กลงมา 

                      

 

การปรับความมืดและสว่างของรูปภาพที่จะใช้งาน 

1.เปิดไฟล์รูปที่ต้องการแก้ไขขึ้นมา 

2. ไปที่เมนู Image>Adjustment>Curve 

 

คลิกที่ตรงกลำงเส้น แล้วดึงขึ้นเพื่อเพิ่ม

แสงตกกระทบ 
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วิธีการปรับเฉดสีของภาพให้เป็นสีโทนที่ต้องการ 

1. เปิดภาพที่ต้องการขึ้นมา  

 

2.จากนั้นไปที่เมนู Images>adjustment>Color Balance 

 

ท าการดึงเฉดสีที่ต้องการ แล้วกด OK 

ดึงเฉดสีที่ต้องกำร 

ปรับส่วนของเงำ Midtones และ 
Highlights 
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